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Chapter 1: Introduction  

What is Metrix?  
Welcome to Metrix Utility Accounting System, the ultimate utility accounting software package! 

Metrix offers easy importing of bill data, rigorous cost avoidance methodology, and Excel™-based 
reporting. This power-packed version of Metrix combines exciting new features with the 

established functionality that energy engineers and energy managers have come to rely on.  

With Metrix, you can:   

• Identify problem areas or equipment failures in order to reduce operating cost overruns.  

• Determine whether you are meeting your utility performance targets.  

• Compare the operating costs of different facilities.  

• Compare the cost-effectiveness of available utility tariffs for your usage profile.  

• Track utilities for any type of facility—commercial, industrial, institutional, residential, etc.  

• Track almost any type of utility, including electricity, natural gas, water, heating oil, 

propane, LP gas, solid waste, sewage, and so on.  

• Track one meter or hundreds, one building or many sites.  

Who Uses Metrix?  
Metrix is for anyone who tracks, budgets, and verifies utility operating costs and savings. Metrix 

provides real answers for tough questions:   

• “Is our energy management program saving as much as we expected?”   

• “Where is my best opportunity for reducing operating costs?”   

• “Are we achieving our performance goals?”   

• “Would I be better off with a different rate tariff?”  

Metrix is used by facility managers, energy managers, property managers, energy analysts and 
energy consultants who want to track utility usage and determine cost avoidance. Some of our 

customers who have found the greatest benefit include: school districts, universities, government 
entities, property management firms, utilities, energy service companies, and consultants.  

Helpful Lessons  
Lessons are available on the Abraxas Energy Consulting website at 
http://www.abraxasenergy.com/metrix-4-tutorials.php  

http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
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It is a good idea to go through these lessons if you have not used Metrix before as they will give 
you a good practical look at the software.  

Cost Savings vs. Cost Avoidance  
Did you know that it is possible for utility bills to increase and still be able to demonstrate energy 
savings? Similarly, a reduced utility bill, compared to last year’s, is actually not the true measure 

of energy savings. If the weather was exactly the same during the two years being compared, 
then a comparison of utility bills might yield accurate “savings.” More often than not, weather is 
not constant, facility operations change, equipment must be repaired, and blizzards or hurricanes 

cause shut downs. There is always a valid reason why corresponding months should have an 
adjusted expected usage for each year. The question then becomes, “How on earth can I 

calculate an expected building usage?” Introducing the fundamental concepts of “Cost 
Avoidance” and “Cost Savings”.  

The problem is: we don’t have any physical instruments that can directly measure Energy or 
Dollars not spent.  

Example Scenario: Suppose a performance contractor installed an energy efficient HVAC retrofit 
in a customer’s store. More efficient means less energy and everyone is expecting to see energy 

costs go down. For June the customer might expect savings from June’s utility bill as shown in 
the Figures below:  

  June 2001 179,359 kWh 

 June 2002 152,455 kWh 

Savings 26,904 kWh 

Figure 1.1 Expected Pre and Post-Retrofit usage for HAVC retrofit example  

Now, let’s change the numbers a bit. What if, the customer saw this?  

  June 2001 179,359 kWh 

 June 2002 197,295 kWh 
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 Increase -17,936 kWh 

  

  

 

Figure 1.2 Pre and Post-Retrofit usage for HVAC retrofit example  

The customer is likely going to be looking for a very good explanation as to why bills were higher. 

Was the wrong equipment installed? Should the energy manager be fired? Energy efficient 
equipment can’t possibly make bills go up, right? Or, is there something else causing this?   

Perhaps, the temperatures in June 2002 were record setting highs, but the previous June had 
been subject to thunderstorms and more moderate temperatures. One would expect the air 

conditioning load to be much higher in the latter year. So, how could you ever measure savings 
from energy efficiency projects? Are all savings truly at the mercy of the weather?  

Of course not, all of the top performance contracting companies normalize their savings for 
weather to show savings and reduce risk. They use analysis tools such as Metrix, to remove 

weather from the savings equation so they can accurately quantify savings.  

The Cost Avoidance approach compares a “Baseline” to the actual bills. The Baseline is a 

normalized value that represents the expected usage for a given set of conditions. That is: how 
much energy a building would have used, based on this year’s conditions. Using your billing 

history, historical weather, and any other significant variables a user enters, Metrix will create a 
regression equation that relates them all together, thereby making it possible to predict an 
accurate expected usage. Users can adjust or “tune” the equation for the best possible fit to the 

data.   

Hot summer? It might be good to know how many kWh the previous air conditioner consumed 
per degree outdoor temp. Busy month? Let’s compare utilities to production volume. Crazy 
calendar? Occupancy might the key.  

The Cost Savings approach does not normalize for weather; there is only a head to head 
comparison of corresponding months between years. This leaves several questions unanswered. 

In the real world of energy analysis, this is completely inadequate.  
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Table 1.1 Cost Savings vs. Cost Avoidance  

 Cost Savings  =  Last Year’s Bill  -  This Years’ Bill  

Baseline (what your building  

Cost Avoidance  =  would have used before the  -  This Year’s Bill 
energy conservation measure)  

There are benefits to both approaches. The table below lists the benefits of both the Cost 
Avoidance and Cost Savings approaches.   

Table 1.2 Utility Bill Comparison vs. Utility Bill Analysis  

 
Cost Savings  

 
Cost Avoidance  

  Will not need to “Tune” meters    Will need to “Tune” meters  

  Simpler method to use    More complex method  

  Do not need to learn concepts behind or 

how to use: “Baseline”, “Target”, 

“Modifications”, “Measures”, “Tuning”  

  Need to understand the concepts behind 

and how to use: “Baseline”, “Target”, 

“Modifications”, “Measures”, “Tuning”  

  Requires less work    Requires more work  

  Easy to explain to others    Can be difficult to explain to others  

  Less accurate representation of savings 

from energy conservation projects  

  More accurate representation of savings 

from energy conservation projects  

  Can compare any year to any year  
  Can compare a Baseline, which is based 

upon one year of data, to current bills.  

  Can make Cost Savings reports, but NOT 

Cost Avoidance reports.  

  Can make both Cost Avoidance and Cost 

Savings reports.  

Established Metrix Features  
 Correction for weather data  

Metrix allows you to correct your utility bills for changes in weather. This allows you to 
make fair annual comparisons of utility bills.  

 Correction for User-Supplied Variables  
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Metrix allows you to correct their utility bills for changes in user-supplied variables as 
well. This includes occupancy, school schedule, production, etc.  

 Multivariable Regression  

Metrix allows users to correct their utility bills for not just one variable (i.e. weather), but 

allows you to make corrections for up to 5 variables. Some meters may supply energy for 
heating and cooling (that is 2 variables), and may vary based upon occupancy (a 3rd 

variable).  

 Variable Balance Point Degree Days  

Weather is imported (or entered) into Metrix as daily high and low temperatures. This 
allows Metrix to calculate degree days based upon different balance points rather than 

just 65 °F. Different buildings start heating and cooling at different balance points, and it 
is less accurate to assume all buildings start heating or cooling at 65 °F.  

 Tuning Statistics  

Metrix supplies R2 values and T-Statistics on the Tuning data form, and CVRMSE and 

Mean Bias Error values on the Tuning Report. These statistics can guide you towards 
performing reasonable regressions.  

 Bill Matching  

If you cannot tune your meter, Metrix allows you to instead compare usage from year to 

year without any correction for weather or user-supplied variables.  

 Meets IPMVP and FEMP Guidelines criteria for Option C Monitoring and Verification  

Metrix meets the International Performance Measurement and Verification Protocol and 
FEMP Guidelines criteria for Option C Monitoring and Verification.  

 Metrix has become the standard for Cost Avoidance for Energy Service Companies  

Metrix is routinely used by the largest Energy Service Companies to monitor their 

performance contracts. Metrix is used because it is an unbiased, industry-accepted, 
easyto-use method for determining and presenting cost avoidance.  

 Hands-on tuning screen  

The tuning screen keeps you from making poor correlations between independent 

variables and your utility bills. Since you are manually performing the regressions, you 
become aware of outliers, poor tunings, and can discover changes in utility usage during 

your Base Year.  

 Easy import of data  

You can easily import bill data, weather data, variable data, and other data into Metrix. 
Imported files are in comma separated variable (CSV) format, and are easily created in 

Excel.  

 Export of data  

You can easily export bill data, weather data, variable data, and other data out of Metrix 
into text files that you can open in Excel.  
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 Export of reports  

You can export Metrix reports into Excel, Word, html or other formats.  

 Baseline modifications  

When the building has substantial changes to its energy usage pattern (i.e. additional 

square feet, or additional equipment), you can easily add modifications to the Baseline 
scenario, which will result in a correct comparison of Baseline and Actual or SimActual 

data.   

 Target Scenarios  

You can easily set up Target scenarios, which you can compare to Baseline, Actual and 
SimActual scenarios.  

 Rate Modeling  

Metrix has a rate engine that can handle most utility rates. Whereas average costs can 

sometimes lead to erroneous results, the rate engine allows you to correctly apply costs 
to utility bills.  

 Average Costs or Rate Modeling  

Metrix allows you to use average costs or model your rates. You can choose either 
method.  

Moving From a Previous Version of Metrix  
NOTE: Before any install, make a complete back up copy of your work! This is just good practice 
for any software upgrade.  

NOTE: Metrix 3 projects saved in Metrix 4 are not backwards compatible. By all means, evaluate 

our software, but only open copies of your Metrix 3 projects when doing so.   

NOTE: All versions of Metrix 4 are compatible among other versions of Metrix 4, but must be 
saved as compatible version. Changes made to a project using the latest features may be lost 

during the save. Users sharing projects in collaborative efforts are strongly encouraged to use the 
same version of Metrix.  

Evaluators of the software should check over meter tunings to see if they have changed. If 
resetting meter tunings:  

 At the project level, under the project preferences tab, un-check “Guarantee Zero Net  

Bias in Regression” and “Max Delta T Demand Tuning”   

 You may also encounter difficulties with bill-matching modifications. If so, you may have 

to delete and re-add the modifications.  

Contact Info  

Mailing Address  
Abraxas Energy Consulting 

PO Box 230  
Santa Margarita, CA 93453   
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NOTE: Abraxas Energy Consulting also has a network of international dealers. Please contact 
the Abraxas Energy Consulting Sales Department for information about contacting an authorized 
dealer in your area.  

Sales Department  
 Sales Phone: 805-547-2050  

 Sales Fax: 805-456-0180  

 sales@abraxasenergy.com  

Technical Support  

We are working hard to provide you with intuitive technical products. In addition, we try to provide 

superior online and print documentation to enable you to work independently in creating your 
Metrix projects. However, should you find yourself with a technical question that cannot be 
answered with provided tools, please contact our technical support department. All of our 

Technical Support Engineers are eager to answer your questions and help you create the best 
Metrix projects possible.  

Metrix Tutorials  

We highly recommend practicing the instruction you receive in this manual on the Metrix 4 
Tutorials. These tutorials are located online at http://www.abraxasenergy.com/metrix-

4tutorials.php. There are eight lessons that cover most of the topics in this manual. This is a great 
tool to get some hands on Metrix training!  

FAQ’s  

At our website, we have provided a list of FAQ’s that covers most of the common issues 

encountered by users. Check out the FAQ’s at the URL below:  

   Abraxas Energy Consulting Metrix FAQ’s: http://www.abraxasenergy.com/faq.php   

Email Questions  

Ask questions and receive detailed answers from the Technical Support Department. Send 
emails to the address listed below. If you think the problem is associated with your project, send 

your Metrix project and we will look it over.  

   Abraxas Energy Consulting Technical Support Email: helpdesk@abraxasenergy.com  

Fax  

Questions or comments can be faxed to Abraxas Energy Consulting. Just send to the fax number 
listed below. You will receive a reply by phone or email.  

   Abraxas Energy Consulting Technical Support Fax: 805-456-0180  

http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
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Telephone  

Abraxas Energy Consulting can be reached by phone between 8 AM and 5 PM, Pacific Time, 

Monday through Friday.  

   Abraxas Energy Consulting Technical Support Phone: 805-547-2050 
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Chapter 2: General Project Layout  
The rest of this manual is a detailed, step-by-step guide to working with Metrix. It is organized as 

follows:  

Setting Up a New Project - Set up the Project layout by defining its Sites, Buildings, and Meters. 

Enter historic data, tune the meters, and establish performance targets.  

Tracking Utility Performance - Enter monthly data and track performance vs. expected savings. 

Modify the Project layout if necessary.  

NOTE: This manual does not cover making reports. For information on making reports, please 

see the Report Maker Manual.  

Should you like some hands on training, see the Metrix Tutorials section on page 9 of this 

manual.  

Overview  
A project is the equivalent of a “Workbook” in MS Excel®, or a “Document” in MS Word®. You 

can set up and maintain hundreds of projects if you want, but you will likely only have one or a 
few. A Project can consist of one building with one meter, or of dozens of buildings and meters.   

Below is an overview of what is involved in project set up. Each item listed below is treated in 
sections that follow.  

Once the Project has been laid out and historic information has been entered, you are ready to 
analyze its past utility performance patterns, and enter expected savings (if any) from your facility 

improvement measures, as follows:   

1. Tune the Baseline to establish typical past utility performance based on historic bills and 

variables.   

2. Enter performance measures that represent anticipated savings from facility 
improvements.   

3. Establish rate tariffs that determine how utility costs and savings are calculated.  

4. Check quality control to catch any potential errors.   

Note: Keep in mind that if you are not performing cost avoidance, and just want to compare year 
to year bills, then you can skip Tuning the Baseline and entering Performance Measures. You 
probably will skip Rates as well.   

After completing these steps to set up a historic model of the Project, it is a good idea to produce 
reports that summarize the Project so far. Details of report making can be found in the Report 

Maker Manual. Once you are satisfied with the Project set up, it is time to start tracking ongoing 
utility performance, as described in the section on Tracking Monthly Performance. This section 

also tells you how to modify the layout of the Project, if it changes during the tracking period.   
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Pre-Project Settings  
IMPORTANT: Currency, Metric/English Units, Tuning Preferences, File Locations, and User 
Information are important to set before any projects have been opened, Very common mistakes 

include:   

• Adding bill data in the wrong currency  

• Saving to the wrong location  

• Blank user info that causes collaboration errors across national borders and time zones  

Avoid costly mistakes and frustration by setting up your software before opening projects. Go to 
Tools > Options from the menu at the top of the Metrix screen. The following Options Dialog Box 

will appear as shown in Figure 2.1.  

  

Figure 2.1: User Options: General Field  

General Tab  

Units - If using Metric Units choose SI units. North American users can choose IP for 

English Units.  

Currency - Selecting Default Currency will adjust all costs to this currency regardless of 

what currency bills are entered in.   

Example 1: a US utility bill of $100 would be viewed by a user in China as $680 Yuan (1 

dollar = 6.8 Yuan approx.) Equal value bill amounts mean less confusion for users.   
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Example 2: if the user in China adds bills to the US project, then they would add a Yuan 

value because they are viewing Yuan. If they are holding bill data for the US customer in 
dollars, then it may be better to open the project in dollars, view dollars, add dollars, and 

then be able to send the project back to the US without errors.  

NOTE: if your Metrix settings are different than those of a project you want to open, you 

will automatically be prompted by the window shown below in Figure 2.2  

  

 Figure 2.2 Currency Conversion Window  

Quality Control - QC Check on Startup can make a quality control check standard when 

you open any project. Quality Control is an extremely helpful tool. All tech support queries 
will start here and a vast majority are resolved by addressing the errors found by Quality 

Control. Users are highly encouraged to leave this box checked.  

View – This box allows the user to set view defaults to suit preference.  

Expanding Project Tree - when open will fully expand all project elements when a project 
is first opened. Typically not a good idea for projects with more than 25 meters; it results 

in too many scroll screens.  

Show Tuning Marks - for Meters deals with the red or green checkmarks that will appear 

next to a meter that is tuned. Green meaning tuned, red for un-tuned. Users who are not 
planning on tuning meters at all are very rare; it is recommended to leave this box 
checked.  

Default Meter Page - selects the tab in the right pane that will be viewed first when 
selecting an item in the project tree.  

Show Item Numbers - will assign a number before the name of any project element. 
Example : Site 5 “Center Building”.  
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Tuning Preferences Tab  

The Tuning Preferences Tab allows users to adjust how auto tuning finds the “optimal” regression 

equation. The default values are recommended unless the user has good reason to change the 
preferences.  

  

Figure 2.3 Tuning Preferences Tab of Metrix Settings  

Equation Formula – When you select auto tune, Metrix will tune many different ways. The 
tuning which results in the largest score for the equation formula is used. The equation 

formula can be adjusted to the users liking by adjusting the statistical indicators within the 
formula, the values they are compared to and the multipliers.  

Multipliers will weigh the statistical indicators within the equation formula to your 
preferences. If you think having a low mean bias is twice as important as all of the other 

statistical indicators, you should put C = 3. If you do not want a statistical indicator in the 
equation, simply uncheck the box to the left of it.  

File Locations Tab  

Carefully select the default locations where you would like to save your projects to prevent losing 
your work.   

Templates are sample project files. There are several pre-loaded into the Metrix software 
in the Resources folder. You may wish to create some templates of your own for 

particular jobs, customers, fuel types, etc.  

Report Maker tells Metrix where to find the Report Maker Program so it may be started 

through Metrix. It does not tell Report Maker where to save reports; this is done through 
the Report Maker Settings.  
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Metrix Data address allows the user to set the default location for where to save projects 

created in Metrix. This will also be applied to data which is exported from projects. NOTE: 
there is an important sample project named GULFMED.PJY in the default folder, data. It 

is highly recommended that users save a copy of this project as a reference or learning 
tool.   

User Information Tab  

Contact Information as including general global location can save much time and frustration in the 
future should your projects ever be involved in a collaborative effort over vast distances. Even for 

the sake of technical support, leaving contact info will be of great benefit. It only needs to be done 
once. Metrix will prompt any other user when opening a project with this information if it detects a 

change in time zone, nationality, currency, or unit system. This helps to prevent improper project 
modifications.  

  

Figure 2.4 User Information Tab in Metrix Settings  

Building a Project Tree Structure  
If you create a new Project from scratch, Metrix provides a “shell” Project as your starting point, 
which is called New_Proj. This contains one each of the required Items for a Project: one Site, 

one Area, one Meter, and so on, as shown in Figure 2.5. You may modify these Items and add 
new ones as needed to set up your actual Project.  

From the File menu, choose New Project. This creates a new “shell” Project.  

From the File menu, choose Save.   

Enter a new file name such as MYSCHOOL without any extension. Metrix automatically adds .pjy 
to indicate that it is a Project file.  
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Figure 2.5: A New Project Created from Scratch  

If the Project is not yet expanded, you can expand the Project Item, and any other item in the 
Tree Structure, by clicking on the plus symbol ( ). The Project contains one or more Sites; each 

Site contains one or more Areas; each Area contains one or more Meters; and each Meter could 
contain one or more Sub-meters. You may add as many of each Item in a Project as necessary. 

Each time you add a new Item, fill in the Data Form associated with it.   

In any location within the Tree Structure, you may make additions by right-clicking on the Parent 

Item above which you want the new Item to appear. Then, from the drop-down menu, click “New”, 
and then select the Item you want to add. Please view Figures 2.6 and 2.7 for more detail.   

A Project’s layout is the organization of its Sites, Areas, Meters, and Sub-meters, which are 
defined as follows:  

Site - the geographic location for one or more facilities. A Project may have just one site 
(a hospital for example), or it may have multiple sites (for example, a school district might 
choose one site per school). All areas attached to a site share the same weather data.   

You may add as many Areas in a Site as needed but remember: Sites contain weather, 

Areas do not. If your Areas require different weather stations, you might want to make 
them Sites instead.   

Area - the portion of a site that has its own meters. Often, an area is a building, but it may be 
part of a building (such as one wing or floor), or it may be a different type of facility (such as 
an outdoor swimming pool). If the meters measures utility use for the whole building, the area 

should represent the whole building; but if the building is divided into sections with different 
meters, each could be a separate area.  

If you are planning on adding your own Variables to your Project, then be advised that  

Variables are attached to Areas. For example, if you have a factory that produces Bolts and 

Widgets, you might want to add the Bolts Produced Variable to the Bolt Assembly Line Area, 
and the Widgets Variable to the Widget Assembly Line Area.  

Meter—the device which measures utility use and possibly demand. You should have historic 
and current utility bills for each meter you wish to track (electricity, natural gas, water, solid 

waste, etc.). Adding data to meters will be discussed in later sections.  
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Sub-meter—a meter which is attached to a meter (for example, it is “downstream” from a 

meter). It is usually used to subtract utility use from its parent meter. For example, if the 
customer adds a new piece of process equipment in year three of a performance contract, 

and you are sub-metering its energy usage, you can use a Sub-meter Item to subtract that 
use from the parent meter.  

Be aware, Sub-meters in Metrix are not like sub-meters in real life. Also you cannot make 
reports at the Sub-meter level in Metrix. Suppose you have a couple of main meters in your 
facility and a collection of sub-meters. In this case, you might want to represent this 

configuration in Metrix by listing the real-life sub-meters as Meters in Metrix, and ignoring the 
main meters. There are many different ways to do this, without double counting usage at the 

Project level. The main reason for using a sub-meter is to remove recently added new usage 
(building additions) from your savings equation.  

A Project must have at least one Site, Area, and Meter. Sub-meters are optional, and rarely used. 
The simplest Project is a single building with a single meter, which would consist of just one Site, 

one Area, and one Meter Item.  

As a general rule, you can make reports at the Project, Site, Area and Meter level. When laying 

out your project, keep this in mind.   

See Chapter 4 for examples of different Project layouts, including complex configurations  

Adding Project Items  

Before adding an Item, use the Tree Structure to find the desired location and select the Parent 

Item above which you want to attach the additional Item.   

For example, in the Tree Structure, the Area Item is attached to a Parent Site Item, as shown in 

Figure 2.6. Thus, to add a new Area Item, you must first click the Parent Site Item that you want to 
attach the Area to.   

  

Figure 2.6: Tree Structure  

From the Edit menu, choose New, or right-click on the Site Item and choose New. A drop-down 

list displays the types of Items you may add in this location as shown in Figure 2.7. Choose to add 
a new Area.  
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Figure 2.7 Right Click Options to add new project items  

Metrix names the new Item with its Item type, which may be followed by a number and a set of 

empty quotation marks. To give it an actual name, click once on the Item to display its Data Form 
(on the right) and fill in the Name field.   

Deleting Project Items  

1. Click the Item you want to delete.  

2. From the Edit menu, choose Delete, or press Delete on your keyboard. (You can also try 

right-clicking on the Item, and selecting Delete from the menu that appears.)  

3. The Delete Block dialog box appears, as shown in Figure 2.8.  

4. Click Yes to delete the Item.   

  

Figure 2.8: The Delete Block dialog box  

Using Elements from Existing Projects  

If you start from an existing Project, you can transform it into a new Project quickly by opening the 

existing Project and saving it to a different name. This may be the best approach when you are 
creating a new Project that is similar to an existing Project.  

From the File menu, choose Open. The File Open dialog box appears, as shown in Figure 2.9.   
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Figure 2.9: Opening a File  

Select and open the old Project you would like to use as the basis of the new Project. A Security 

Check message may appear, noting who last modified the existing Project.  

From the File menu, choose Save As and save the Project under a new name.   

Using the Pre-made Project Elements  

Metrix has common projects elements such as rates, meters, etc. pre-made for users to 

copy/paste into their projects.  

Go to: hard drive > program files > Metrix 4 folder > Resource Folder.  

The .TPY files are template files. NOTE: use copies of these to avoid ruining the templates.  

These files are typically very similar to Gulf Med, but they have a project element within them.  

Navigating Large Projects   

Projects may contain hundreds of meters. For these instances navigating through the project tree 

is made simpler by sorting project elements by parent or by type. The option to change from the 
standard tree structure to the sorting option is found just above the left hand pane. (Shown below 
in Figure 2.10) If you do not see these bubble options directly above the project tree, go to the 

View > Show List View to make it appear.  

  

Figure 2.10: View Options  

Items can be sorted by Meter, Area, or Site. Figure 2.11 below shows a meter level view sorted 
by parent. Notice in that the Tree Diagram has been replaced with a listing. Click on each of the 

drop down menus to see what options are available.   
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Figure 2.11: List Style View allows users to sort project items  

Project Data Panes  

Project Information Tab  

Typically the project information tab only needs to be set during initial project build up. (Users can 
also refer to Metrix Lessons for more information)  

  

Figure 2.12: Project Information Tab  

Name, Description, ID – descriptive information concerning the scope of the project. The 
ID field is optional.  

Country – it is highly recommended this field not be left blank. Metrix checks this against 
the user settings on the computer it is being opened on to adjust for currency.  

Reference Year – allows users to set what month will be at the end of a 12 month year 
when reporting. For example: if your fiscal year ends September, select that month from 

the drop down menu.  
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Current and Entry Close Dates:  

• Current Date, Use System Date – Metrix is asking the user what day today is. By 
checking the Use System Date box, the program will sync with the date on your 

computer. It is recommended to leave this box checked.  

• Entry Close – Only if a project has been protected with a “Read Only” Password 

will this setting take effect. Allows users to lock out data from being adjusted 
beyond a certain date. Password settings are found under the File > Set 

Password.  

Milestone Dates - serves as helpful reference information to users. Most commonly 

associated with performance contracting. This information is optional.   

Contact Information Tab  

All of these fields are self explanatory. Fill in company information and any contacts as desired.   

(This information is also used by the Metrix Report Maker when using the “Email Report” feature.)  

Note: these fields are applied to the project file, not to your installation of Metrix. The contact 

information that can be entered in the Pre-Project Settings under Tools > Options is assigned to 
your installation of Metrix.   
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Project Preferences Tab  

  

Name – sets the name of the project.  

Project Preferences:  

• Tune Only Sum TOU Periods – Only for use when there are multiple Time Of Use 

Periods. Metrix will sum all these periods and tunes to that value. If unchecked 
users will need to tune each TOU period individually; that can be difficult.  

• Override User Bill Selection / De-Selection – if Metrix is unable to tune the data 
with the user’s selected bills, it will select or de-select any that would result in a 

better set of statistical indicators (with a maximum number of bills selected). Only  
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bills within the total span chosen for the base year are considered for 

selection/de-selection.  

• Override User Tuning Variable Selection – if Metrix is unable to tune to all or 

some of the users tuning variables, it will select or de-select any that would result 
in a better set of statistical indicators.  

• Max Delta T Demand Tuning – Metrix will only consider the day with the 

maximum number of Degree Days for a given bill. This only applies to demand 

metering where the demand is billed for the highest value in a given period, but is 
not a requirement for all demand situations.  

• Guarantee Zero Net Bias in Regression – Sets the net zero bias to zero. Note: 
may cause meter tunings to change. Tunes the regression equation so that the 

Baseline values are within .005% of Actual values in the Base Year. It is highly 
recommended this remain checked.  

• Use Zero Default Degree Day Threshold – if unchecked the default degree day 
threshold is 2 degree days. Any bill period containing less than 2 degree-days will 

be automatically de-selected. Example: a gas meter would have no HDD in 
summer, so those months would be de-selected. Checking this box is optional 

but recommended. The reason is that bills with few degree days will tend to have 
a zero for the weather related term in the Baseline Equation anyway so they can 

be left as selected.  

• Set All Bill Cut Off Dates to – Metrix will set all bill cut off dates to match the 

options that are selected  

• Set All Tuning Periods to – Metrix will set all tuning periods to match the setting 

selected i.e. number of bills and starting bills  

• Automatic Bill Cut Off Dates – by pressing this button all bill cut off dates will be 

applied following the follow rules o  If the bills are not near the 15th of the 

month, Starting on 15 will be used  

o If the bills are near the 15th of the month, but mostly higher, Starting on 

25 will be used  

o If the bills are near the 15th of the month, but mostly lower, Starting on the 

5th will be used.  

• Save Projects As Metrix 4.4- will save all projects as Metrix 4.4 compatible. The 

new Metrix 4.5 features such as Monthly Minimum costs are not available in a 
project saved as 4.4 compatible. For projects created in Metrix 4.4, this box will 
be checked by default. New projects will have this option un-checked.  
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Tuning Requirements Tab  

These are numbered as they appear in the Metrix screen Note: the default settings are highly 

recommended.   

1. R2 (Quality of fit): 0.75 or higher, with 1.00 as perfect fit.  

2. CVRMSE Eng (Coefficient of Variation Root Mean Squared Error): 25 or lower for 

consumption meters.  

3. CVRMSE Dmd (Coefficient of Variation Root Mean Squared Error): 35 or lower for 

consumption meters.  

4. Abs (Mean bias) - Must be equal to or less than 0.005.  

5. Abs (T-Stats) - Positive 2.0 or higher for CDD and HDD, and greater than 2.0 or less than 
-2.0 for any user variable.  

6. HDD and CDD T-Stat > 0. This box must be checked to be ASHRAE and IPMVP 

compliant. The reasoning behind this is that an increase in HDD or CDD should correlate 
with an increased amount of energy use.  

7. Tuning Constant >= 0. This box must be checked to be ASHRAE and IPMVP compliant. 

A negative tuning constant implies that when all variables tuned to are zero, there is 
negative energy usage.  

Report Groups Tab  

(See section “How to Use Grouping in Metrix”)  

Notes Tab  

Click the Add Note Button and enter the Date, User, or Note as you wish. Any portion of this 

information may be left blank if desired. Any information entered into these fields many be 
changed at any time. Note: be sure to click Save Notes. The asterisk indicates new changes have 

not yet been saved.  

User Data Pane  
The operator’s name, contact email, address, and phone numbers will appear in the reports.   

In the tree diagram, click the User Item to display the User Information data form, shown below.  
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Figure 2.13: Project Information Tab  

Since all of these fields have been entered in the user form in the Pre-Project settings, this form 
can be auto-populated by clicking on the button that says Copy from Options | User Info.  

Site Data Panes  
As a reminder, sites are typically designated by their street address. Sites have their own 
weather. Many sites can all be in the same city (and thus would have the same weather added at 

each site) but that is not the same as making each building at the same address its own site. For 
an address with many buildings, each building would be better designated as its own area within 

the same site.   

Site Information Tab  

Name, Description, Country – these are self explanatory. Tip: keep in mind that large 
projects can be sorted by description as well.  

Current Floor Area - Metrix automatically sums the Current Floor Area field from all 
building areas that are part of this Site.   

Groups – (see section How to Use Grouping in Metrix on page 92)  

Contact Information Tab  

These are self explanatory. Enter contact info pertaining to that particular site where applicable.  

(This information is also used by the Metrix Report Maker when using the “Email Report” feature.)  

Area Data Panes  
As a reminder, all areas at a site will have the same weather of that site. Typically, they also have 

the same address but are unique in construction to warrant splitting the utility tracking. An 
example: east and west wings of a single campus where usage is not similar.  



Metrix 4 User’s Guide    Chapter 2: General Project Layout  

  
    

 28 

Area Information Tab  

Name, Description, Country, State – are all self explanatory. Tip: keep in mind that large 

projects can be sorted by description as well.   

  Type of Area – select from the drop down menu  

Groups – (see section How to Use Grouping in Metrix on page 92)  

Current Floor Area – this is editable only from the fields below with the column headers: 

Date, Total Area sqft, Percent Condition, Comments. If a user is interested in 
benchmarking their facility, this information is required.  

Contact Information Tab  

These are self explanatory. Enter contact info pertaining to that particular site where applicable.  

(This information is also used by the Metrix Report Maker when using the “Email Report” feature.)   
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Meter Data Panes  

Meter Setup Tab  

Name, Account, Description – Relatively self explanatory, these determine the name for the 

selected meter, assign an account # to it, and allow the user to enter a description. Note: the 
account you enter must exactly match the account # on the Import Tab as well. Metrix will 

automatically prompt users when a change occurs in the account # in either tab and offer to 
synchronize them for you.  

Utility – Select the utility type from the drop down menu. Notice the units associated with the meter 
type will also change accordingly.  

Degree Day Calculation Method:  

• Daily Degree Days - are the difference between the average temperature for a day and 

the selected balance point.  

• Degree-Hours/24 – when checked, assumes a standard hourly temperature profile for a 

day when hi/low weather is available. Averages HDD and CDD separately based on this 
profile. Can provide CDD and HDD for a given day. Note: not recommend for most 

projects.  

• Max Delta T Demand Tuning – Metrix will tune the meter according to the highest degree 

day recorded for a billing period. Note: this can be, but not always be, a more accurate 
way of correlating demand data to weather. It is based on the idea that the highest 

demand will occur on the day of the highest weather differential. While that is the case for 
many buildings, it is not always perfectly reflected how the building is metered.  

Utility Pricing  

• Single Utility Rate Schedule – Applies the rate and charges to the meter; most common 

user setting when rate tariffs are available.  

• Avg. Cost/Consumption & Cost/Demand – if a rate has not been entered for this meter, 

Metrix will calculate an average cost/consumption unit or cost/demand unit. Where the 
cost has been entered in the On Peak Cost Column in the Bill Register. (Not to be 

confused with the Total Cost Column in the Bill Register.) This column should only be 
used when the Detailed Cost Box is checked next the # of TOU Periods box. If the “Do 

not proportionally adjust Misc Costs when calculating Avg. Cost/Energy and Avg. 
Cost/Demand” box is checked, the Misc $ amount will be identical in the Simactual and 

Baseline. Otherwise, the Misc charges are adjusted based on whether the energy 
consumption and demand costs increase or decrease. The Credit $ amount behaves in 
the same way.  

• Avg. Total Cost per Consumption – if a rate has not been entered for this meter, and the 
only cost available is the Total $ column, Metrix will use the total cost/consumption or 

cost/demand. Taxes, Credits, and Miscellaneous Costs are all included in this calculation 
method making it less precise. It is helpful as an estimate tool or when rate tariffs are not 

available.  
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• Min/Unit – over-rides the any consumption unit pricing below the set limit. If the Monthly 

Minimum radio button is selected, users may enter a monthly minimum cost.   

• Min/ - over-rides any demand unit pricing below the set limit. If the Monthly Minimum 

radio button is selected, users may enter a monthly minimum cost.  

• Notes – Allows users to record or communicate information of their choosing.  

Register Tab  

This contains the Actual Utility Bill Data for the meter.  

(See section: Entering Historical Data for more information concerning Data Entry and Feature 

Available to all Data Registers)  

# TOU Periods – Time Of Use Periods. Adds columns to the Bill Register when more than one 

consumption quantity is available.  

Detailed Cost – Adds a cost column next the consumption column in the Bill Register when utility 

bill data is available with the unit cost broken out from the total cost. (that is, with no tax, or 
service charges)  

1st Day of First Bill – All of the bills in the register (except the first) contain only one date, the end 

date. Implicitly, the start of each bill is the end of the previous. A common question is how to 
ungray the 1st day of bill box. When the bill register is not all the way at the top, the 1st day of bill 
will be locked. To unlock, simply scroll to the top of the bill register. Note: Another common error 

is to leave this field unadjusted, resulting in an improper baseline for the first month.  

Total $  

• Automatically Calculated will over-ride any pre-existing costs in the Total Cost Column by 

summing any Detailed Costs, Tax, Credits, or Misc. Costs. You must have at least one 
Detailed Cost column turned on in order to select this feature.  

• Manually Entered – Allows users to enter any amount into the Total Cost Column.  

Bill Cut Offs –  A bill cut off date is used in Report Maker to assign the bills to a month based on 

the day the bill ends. This feature is necessary since bills do not always start on the first day of 
the month and end of the last. If a bill ends on May 31st, it is a May bill, if it ends on June 1st, it is 

also a May bill. However, when a bill ends on June 15th it becomes more difficult.   

Metrix will determine how to assign these bills based on the options the user selects.   

For example, if the user has the options “Starting” and “15”, this means that if you look at a bill 
end day, the bill will be considered the month that the bill ends in if the bill end day is between the 

15th of the month the bill ends in and the 14th of the next month.   

Specifically, if the bill end on 6/22 and the options “Starting” and “15” are selected, the rule is:  

All bills that end between June 15th and July 14th will be considered a June bill. Since the bill ends 

on June 22nd it is between the period and the bill will be assigned to the month of June for 
reporting purposes.  
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In the Project Preferences tab, there is an option to set all bill cut off dates for all meters manually 

or automatically.   

Tuning Tab  

(Also: see Complete Meter Tuning for information concerning interpreting the data displayed in 

this data pane)  

Tuning Period - this is set by the # of Bills and Start at #. Check the “starting on” and 

“ending on” dates to verify settings are correct.  

• # of Bills – this is the # of sequential bills that a user would like to use as the basis for 

the Baseline Equation. (not necessarily the total number of bills)  

• Start at # - sets the first bill of the # of sequential bills based on the bill register. (i.e. if 

there are 13 bills, and you tune for 12 months, setting this to 1 excludes the last 
month)  

TOU Period – Only if “Sum TOU periods” has not been checked. Choose the desired 
consumption data to tune for.  

Show Eng/Day – displays the ratio of utility unit per day for each bill in the mini-register.  

Show Degr Days – displays the number of Degree Days for each bill in the mini-register.  

Tuning: Closed Check Box – checking the box for closed will lock the current tune of the 
meter in whatever state it is in.   

Tuning: Manual Check Box - checking the box for manual allows users to directly enter 
Baseline Equation Regression Coefficients.  

Auto Tune - (see section on Complete Meter Tuning for details)  

Bill Match – (see section on Bill Matching in Complete Meter Tuning for details)  

Set Fit to Zero – clears the Baseline Equation Coefficients. Note: all meter tuning will be 
lost.   

“Tune With”: Check boxes – selecting these tells Metrix what variables to tune with. The 
default boxes are HDD and CDD for heating and cooling degree days. Additional boxes 

will appear for user defined variables when they are added.  

Bal Point – (see section on Complete Meter Tuning for details)  

Thresh – (Threshold) the lowest number of HDD and CDD of the bills selected in the 
tuning period.  

RegrCoeffic: (Regression Coefficient) Matches the tuning variable coefficient in the 
Baseline Equation. Tip: compare to the numbers in the Baseline Equation displayed in 

blue.  

T-Stats – (see section Statistical Indicators in Complete Meter Tuning)  
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Baseload: (Regression Coefficient) Matches the # Days coefficient in the Baseline  

Equation. Tip: compare to the days coefficient in the Baseline Equation displayed in blue.  

Graph X-Axis – select from the drop down menu the desired units for the graph. (see 
Complete Meter Tuning for details)  

Moving S/A – (Moving Smoothed Average) helps to show general trends, but should not 
be used while tuning.  

Scenario Inspection  

Many of the controls displayed on this tab have very similar counterparts in the tuning tab. 

However the main purpose for the scenario inspection tab is for users to be able to see a visual 
comparison of their Baseline, Actual, SimActual, and Targets and values for each individual 

scenario  

Use the check boxes to add or remove any of these 4 scenarios to you graph. Be sure to select 

the different x-axis available as well.  

Baseline Scenario - utility usage for the meter is calculated by Metrix based on the 

meter’s past typical performance. The Baseline is usually compared with the Actual 
Scenario to see if any savings are being achieved, or to see if utility usage is changing 

over time, after correcting for weather and other variables. The Baseline usage is 
calculated by Metrix with coefficients you derive from tuning the meter. Costs for the 

Baseline Scenario are calculated by Metrix based on the Cost Calculation Method 
selected in the Meter Setup Data Form.  

Target Scenario - reflects the goal or budget you establish for utility usage and costs. For 
example, if you were implementing an energy management program which you expect to 

reduce your utility costs by 30%, you would set up the Target Scenario to be 30% below 
the Baseline. Then, you can compare the Actual utility costs to the Target, and determine 
if you are achieving your goals. The Target usage is calculated by Metrix by applying 

Measures to the Baseline usage. Costs are calculated by Metrix based on the Cost 
Calculation Method selected in the Meter Setup Data Form.  

Actual Scenario - reported usage and cost are taken directly from the utility bills for the 
meter. These are entered by the user or automatically imported into Metrix if the bills are 

available in electronic format.  

SimActual Scenario - utility usage is taken directly from the utility bills, as it is in the  

Actual Scenario. But costs are calculated by Metrix based on the Cost Calculation  

Method selected in the Meter Setup Data Form. You can use the SimActual Scenario to 
validate the utility billing, or to compare the impact of alternative rate tariffs on utility bills.  

SimActual Tab  

The cost values in this register are calculated using the Actual Consumption or Demand 

according the rate for that meter. This is also subject to the cost calculation method selected. (see 
Meter Setup Tab) If no rate has been entered, it will be a duplicate of the Actual Bill Register. It 
will always display grey-ed out data, and users cannot directly edit the fields in the register.   
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This information is useful when comparing billed costs to published rate tariffs; especially when 

there is a billing discrepancy. Sometimes alternate rates are available for a given building; by 
modeling both rates, users can compare if to see if the alternate is more beneficial.  

Import Tab  

Name, Utility, Account – Metrix uses these fields when importing or exporting meter data. Note: It 
is critical that these fields match their counterparts of the same name in the Meter Setup Tab. 

Metrix offers the user to automatically synchronize these fields by prompting the user anytime 
there is a change made.  

Monthly Minimum Tab  

This tab will only be visible if the ‘Monthly Minimum’ radio button is selected in the Meter Setup 

Tab.  The tab allows users to set a rate that will override any consumption unit pricing below the 
set limit.  The user can also repeat the rates set after the first year based on a fixed percentage 
increase.  
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Chapter 3: Populating the Databases  
Manual Entry vs. Import Files  

When the term “Manual Entry” is used, data is being added directly where it is viewed in the 
register where it is stored. Pro: simple, intuitive. Cons: too slow for large projects.   

Import Files allow users to add, modify, or transfer large amounts of data in one swift move. 

Example: an initial project build involving 10 years of billing history should not be entered one bit 
at a time.  

All data registers can be modified manually or with an import file  

Types of Data Registers  

“Registers” are the row/column spreadsheets of Metrix data. There are different kinds, designed 

for each type of data they are meant to contain. Users can inspect or modify the data through the 
registers, although there are other methods as well. The types of registers are:  

• Utility Bill Register  

• Weather History  

• Modification History  

• Measure History  

• Fuel Adjustment   

• Variable Information Register  

• Sub-Meter Register  

Each of these is discussed fully in their own respective sections; the intent of this section is to 

introduce the commonalities among them.  

Functions Available for All Data Registers  
Most common is the manual form of data entry directly into the cell where it is viewed. A single left 

click on the desired cell is sufficient to begin editing. For correcting typos small amounts of data 
this is fine. Note: Data entry or editing for medium to large projects should involve copy/paste 

functions from Excel or creating import files.  

Manual Entry  

A single left click on any cell of a data register opens it for editing. This is very straight forward. 

Good for small adjustments, but definitely not the preferred method for project level data entry. 
Continue reading for more powerful data entry tools like copy/paste and import files.  
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Figure 3.1 Editing the Bill Register  

Right Click Options  

A standard palate of 5 options is available by right clicking anywhere in register window pane. 
They are:  

• Add Row (New) - Creates a new blank row beneath the last data entry  

• Add Row (Copy) – Copies any highlighted row and pastes it beneath the last entry. The 
dates will need to be changed to avoid having a duplicate bill.  

• Delete Row – deletes the highlighted row.  

• Select All Rows – highlights all the rows in the data register so they may be copied without 

the column header; useful for pasting to a larger list in Excel.  

• Copy All Rows – copies the entire data register including the column headers; useful for 

pasting into Excel.  
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Figure 3.2 Data Register options for blank space right click  

Copy / Paste For Any Data Register  

Select the desired Metrix data to copy with a right click anywhere in the data register. You can 
choose Copy All Data, OR choose Select All Data then Ctrl+C. The entire data register can now 

be pasted into Excel by right clicking the cell where you want the top right column/row cell to be 
and choose paste. Individual rows may not be selected for a partial copy of data register, but a 

single cell can.  

Sample Copy / Paste from Excel from Metrix:  
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Figure 3.3 Copy from Data Register to Excel  

The paste function can be used very similar to how one would expect to use it in Excel, but with a 

couple of important differences. Notice both what it can and cannot be used for.  

Users may paste into a data register in the following ways:  

• Value of a single cell  

• Replace entire rows  

• Replace partial rows  

• Replace the entire register  

• Add any number of rows  

While very close to a typical paste function, it is not completely identical. For example:  

• May not add columns, column # and type must match before the paste operation.  

• May not paste in between rows  

• May not subtract rows; they must be manually deleted  

Sample Copy / Paste into Metrix from Excel:  
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Figure 3.4 Pasting a single row with matching date from Excel  
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Figure 3.5 Pasting partial rows into data register  

Note: Because data registers contain time dependant data, they must always be handled 
sequentially. Users must be conscious of the order of utility bills, days in weather, etc. before 

pasting data into Metrix. Failure to do so will result in the error: “Meter Reading Dates Are Not In 
Order”. It will be impossible to obtain results until this is corrected.  

Note: the number of columns pasted into Metrix will be truncated to match the existing number of 
TOU periods and corresponding detailed costs. It is possible for information to be lost if they do 

not match. For this reason users are recommended to 1) carefully inspect the number of TOU for 
consumption, demand, etc. and 2) refrain from using the “cut” function when moving data from 

Excel to Metrix. If there is an error using copy, there is still a backup in Excel.  

Meters  
Clearly, there must already be a meter set up; users are encouraged to carefully examine project 
and meter preferences. Keep in mind what sort of cost calculation methods will be appropriate.   

Utility Bill Register  

Utility bill data is the primary data that exists at the meter level and it is stored in the “Register” tab 

of the meter item in Metrix.  

1. Click the  next to the items in the tree until you navigate to your meter.  

2. Single left click on the meter item to display all information pertaining to that meter in the 

right hand of the screen.  

3. Then select the Register tab to display the Bill Register.   
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Figure 3.6 Historic Electric Bill Data  

The electric meter in this sample measures consumption (kWh) and demand (kW), but not 

reactive energy or power factor. There is only 1 time of use period designated by the number 1 in 
the “# TOU Periods”.  

Because the fictitious utility company provided bill data with consumption and demand costs 
broken out from the total amount, we can check the Detailed Cost box and add that data to our 

project. For Supply and Power Factor, a zero must be entered because we do not have data for 
those fields. The Detailed Cost check box for Supply must be cleared also.   

A feature in Metrix 4.4 is the estimated bill column. It is useful when utility companies miss their 
meter read dates, the bill is often an estimate based on the same month from the previous year 

(bill matching) only to be corrected after the next meter read. Having the ability to indicate whether 
a bill is estimated or not can save a lot of headache when trying to explain an outlier month, where 

usage was expected to be different than it appears.  

  

Figure 3.7 Indicating an Estimated Bill  



Metrix 4 User’s Guide    Chapter 3: Populating the Databases  

  
  

   41 

  

Importing Bill Data  

Utility bill data is imported in the *.mt1 file format. This section covers how to import bill data that 

has already been formatted into the import file format. For details on how to create an *.mt1 file 
see Appendix C on Import file formats.  

1. From the Tools menu, choose Import or click the Import button  on the Toolbar or go to 

Tools > Import. The File Select dialog box appears, shown in Figure 3.8.   

  

Figure 3.8 Selecting the Import File  

2. Choose Bill Data, *.mt1. Select the file you wish to import, and click Open.   

Case 1: Import file matches “Import” tab in the Meter item.  

Metrix looks for a Meter Name and Account in the import file that matches up with 
a Name and Account of a preexisting meter in the project. Any import meters that 
can be matched are imported automatically.   

Case 2: Import file does not match “Import” tab in the Meter item.  

Any meters that could not be matched are shown in the Match Import Meters to Project 
Meters Dialog Box, as shown in Figure 3.9.   
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Figure 3.9  Match Import Meters to Project Meters Dialog Box  

Note: You will not be able to select “OK” until you have dealt with ALL of the unmatched 

meters.  

Option 1: Update Selected Project Meter from Selected Import Meter  

a. Select a meter in the Import Records box and match it to the correct meter in the 
Project Records box. Click on “Update Selected Project Meter from Selected 

Import Meter”.   

b. Continue matching meters in the Import and Project Records boxes until you 

have imported all the meters you want.   

Option 2: Skip Selected Import Meters  

a. If there are any meters in the Import Records box you do not wish to import, 
select them in the “Import Records” field.   

b. Click “Skip Selected Import Meters”  

Option 3: Create New Project Meter(s) From Selected Import Meter(s)  

a. If there are any meters in the Import Records box you do not wish to import, 

select the meters.  

b. Click “Create New Project Meter(s) From Selected Import Meter(s)”.   

This creates a new Site Item at the bottom of your project called “NEW METERS” 
which contains all the unmatched meters.   

Hidden Option 4: Cancel  
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Chances are if you get this screen you have done something wrong in your 
import file. For this reason we recommend:  

a. Select “Cancel”  

b. Go back to your import file and double-check that you did everything correctly.  

Manually Entering Bill Data  

You can enter current bill data manually in the Meter Register Data Form. This is a 
spreadsheetlike input format. Each row contains all the cost and usage data for one period.  

1. From the Tree Structure, click the Meter you want to add data to.  

2. Click the Register tab to view the Meter Register Data Form, shown in Figure 3.10.  

3. Scroll down to the end of the existing bill data, and enter a new row for the current period. 
Enter the end date for each period in the Period End column, and charges and usage for 
that period to its right.  

To add new rows, right-click anywhere in the data form. Select “Add Row (New)” to add a blank 
row with today’s date. Select “Add Row (Copy)” to add a copy of the row you right-clicked on. You 

must change the date before moving on.   

You may also use the arrow keys to move about the form. To add a new row, move to the last row 
and hit enter, or the down arrow.   

  

Figure 3.10 Meter Register Data Form  

Important If you are missing one or more inputs, enter –0. This displays a -0 in the register for that 

input. Do not enter them as 0, in order to avoid confusion with bills that are genuinely zero. All 
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inputs that are -0 are treated as missing data by Metrix, which automatically excludes them from 

the tuning regression. For example, if on-peak kWh usage is missing for one bill in an electric 
meter, enter -0. You will also notice that this bill is automatically excluded from any tuning 

analysis.  

Weather  
For Metrix projects, weather will affect electric and gas usage in the baseline scenario. Weather is 

stored at the Site level. When laying out a project, understand that Sites are usually unique 
geographical locations that have their own weather patterns.   

Weather Information Tab  

Metrix needs to assign a name to the weather location. This is defined by Source Location ID.  

Enter in the 3 to 4 letter airport code where the weather data was collected. Example: LAX for Los 

Angeles, California. Major cities will have more than one airport; user discretion is required to 
determine which is most appropriate.  

Weather start and end dates must be entered as well. Tip: bill dates often do not perfectly align 
with the 365 day calendar year. It may be necessary to add an additional month of weather at the 

start or end of the tuning period to cover any days that ‘spill’ over into the previous/following year.  

  

Figure 3.11 HDD in the Degree Day Tab  

Weather History  

The weather data is in Hi-Lo format for this sample project. A graphical representation of the data 
is at the top of the screen. All data may be edited directly into this register. This is useful for 
correcting errors or fill gaps that may be the result of severe meteorological events (example: 

hurricane, tornado, etc.) Typically users will use an import file to keep this information current. 
Import files are discussed in a later section.  
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Figure 3.12 Weather History Data Form  

Degree Day Tab  
Metrix versions 4.4 and later include a Degree Day Tab that allows users the ability to quickly 
analyze weather data with respect to the ASHRAE standard balance point of 65°F. Users will use 

this information for analyzing weather data independently of meter tunings. For the purpose of 
comparing different locations, years or months, it is important to have identical balance points.   

Note: Meters may need to have a different balance point based on the intended application 
(example: industrial meat packing facility could be tuned 40°F).  

  

Figure 3.13 HDD in the Degree Day Tab  
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Importing Weather Data  

You can import historic weather patterns for a given city from an external file. It is very important 

to enter the correct Source Location ID, as shown in the exercise, because Metrix uses this ID to 
match the external data with the Item when the data was imported.   

From the Tools Menu, choose Import. Select Weather Import Files, (*.hlt, *.avt) from the Files of 

Type list. In the Files list, double-click mobhist.hlt and mobtrak.hlt to import them. A dialog box 

will appear indicating the import was successful.   

Note: The Source Location ID in the “Weather Information” tab must match the import code in the 

weather file. If Metrix finds a Site in the project without a Weather Item attached, you are notified 
that a specific sight has no weather and you are asked to assign it a Source Location ID from all 

those available in the import file(s).  

Double-click the Weather Item to display the Weather Setup data form again, and click its 

Weather History tab to see the history of the daily temperatures that you have imported, as shown 
in Figure 3.14.   

  

Figure 3.14 Historic Weather Data  

Important: If you are missing one or more inputs, DO NOT LEAVE BLANKS IN WEATHER DATA. 
If you have no way of finding the correct data for that day, average the high temperatures from the 

day before and after the gap, and use that value. Do the same for the low temperatures. Leaving 
blanks will result in an incorrect baseline calculation. This type of error will also be flagged during 
Quality Control, which will be discussed in a later section.   

How to easily Obtain Weather Data  

As an option, users can purchase weather data from Abraxas Energy Consulting. Hi-lo weather 
data is emailed to you monthly and the user simply clicks import to import the weather. You can 

search for weather data by following the link below:  

https://www.abraxasenergy.com/energytoolbox/weathersearch.php  
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Manually Entering Weather Data  

From the Tree Structure, select the Weather Item you wish to add data to.   

Click History to open the Weather History Data Form, shown in Figure 3.15. This Data Form 
enables you to enter past weather data.  

To add new rows, right-click anywhere in the data form. Select “Add Row (New)” to add a blank 
row with today’s date. Select “Add Row (Copy)” to add a copy of the row you right-clicked on. You 

must change the date before moving on.   

You may also use the arrow keys to move about the form. To add a new row, move to the last row 

and hit enter, or the down arrow.   

  

Figure 3.15 Weather History Data Form  

Modifications  
During the life of a facility, there will inevitably be changes in usage patterns. If savings are to be 

calculated properly, these changes must be accounted for. Modifications let you modify your 
Baseline for changes in utility usage due to facility modifications and special events that would 
otherwise inaccurately influence your Cost Avoidance (these may occur once, periodically, or 

consistently).   

Modifications let you account for miscellaneous changes in the Project that affect utility usage.  
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They will usually (but not always) increase utility usage and costs. Modifications affect the 

Baseline Scenario and thereby also the Target Scenarios. If you create a modification for a 
natural gas meter that increases usage by 25% per month (because, for example, a ceramics 

plant adds a large gas-fired kiln), then both the Target and Baseline Scenarios will show a 25% 
increase in therms over what they would have been without the modification.  

This section discusses how to apply Modifications, and mentions differences for applying 
Measures when necessary. Each subsection explains the important points of each type of 
Modification.   

Direct Entry – Enter changes to individual bills manually.  

Regression Modifiers – Enter modifiers to the fit line to change the regression equation directly.  

Modifications – Direct Entry  

Direct entry modifications are the most common and the most useful way to modify the baseline to 

account for changes in usage that would otherwise obscure or magnify savings. A convenient 
example is a school which experiences decreased operation during the summer.   

The example file schl_sum.tpy illustrates this example. From the File menu, select Open 

Example. Choose schl_sum.tpy and click Open.   

Click the Tuning tab to view the Tuning Data Form.    
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Figure 3.16 Tuning Data Form, Modification Line   

Expand the Tree Structure to show the “Summer Shutdown” Modification attached to the “Primary 

Elec” Meter, as shown in Figure 3.17.   

  

Figure 3.17 Tree Structure, Modification Item  

Click on the Modification Item to display the Modification Setup Data Form shown in Figure 3.18. 
Notice that, in the Specification Options field, the selected option states “Directly Enter Factor 

History of periodic changes in utility usage”. This is the default option for Modifications.   
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Figure 3.18 Modification Setup Data Form   

Notice the Effective Dates for this Modification. These dates should be set to the time period to 
which you want this Modification to apply. Generally Modifications should not apply to dates within 

the Tuning Period. Modification dates should only be applied to the Performance Period. In the 
example project shown, the Modification Period begins the January after the Performance Period, 

and extends until the end of the Performance Period. This value could be changed later, if 
necessary.   

Click on the Modification History tab to view the Modification History Data Form, also known as 
the Factor History Form, shown in Figure 3.19.  
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Figure 3.19 Modification History Data Form, a.k.a. Factor History  

Notice that the summer months have Modification values which subtract usage. This represents 
the reduced amount of usage expected. There are a number of important elements in this Data 

Form:  

Time Periods: The Time Periods field designates how the dates are delimited in the End Dates 

column. The Monthly option designates the End Dates to fall at the end of every month. The 
Quarterly option would cause dates to fall at the end of every quarter. The Billing Periods option 

causes the End Dates to reflect the bill dates in the Register. Note that changing the Time Periods 
field after you have entered Modification values causes them to be reset or offset to different 
months.   

Auto-Repeat: Rather than requiring you to copy the Modification into every year that it applies to, 
you must only fill in the first year. Metrix will copy the Modification into the corresponding time 

period every year thereafter, for the life of the Modification. The Modification must, however, cover  
365 days of bills. Near the bottom of Figure 3.19 is a message which reads “The last 365 days of 

% changes or offsets entered in the first <13> rows through <1/31/1994> will auto-repeat 
thereafter on a 365-day cycle except in manual rows.” This field allows you to offset the beginning 

of the modification. In Figure 3.19 the last, or most recent, 365 days contained in the first 13 bills 
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(ending on 1/31/1994) will be repeated until the end of the modification, which you set in the 

Effective Dates field in the Modification Setup Data Form.   

Manual Entry: To the left of the End Dates column, the Manual column allows you to select 

specific bills. If you check one of these bills anywhere except in the first year of the Modification, 
you may make additional adjustments to account for special, one time occurrences. These 

changes will not be auto-repeated, and they will override the auto-repeat function described in the 
previous item.  

Modifications - Regression Modifiers  

In the preceding section for Direct Entry, we saw how a Modification can be used to account for a 
school which shuts down most operations in summer. Here is a similar situation: a school which is 
operated differently during summer vacation months. However, in this example, the school is still 

in significant use during summer, and the electric use in summer correlates well with cooling 
degree-days. But the correlation is very different than it is during non-summer months.  

So what we need for this meter are two sets of tuning coefficients—one set for the school year and 
a different set for summer vacation. Metrix lets you set this up using a Modification.  

To illustrate this, consider an elementary school in which some classrooms are closed throughout 
each summer, from about June 15 - September 15. The remaining classrooms and administrative 

offices are air conditioned throughout the summer. In the Tuning Data Form, we determine that 
there are separate fits for summer vacation months and school months.  

From the File menu, choose Open Example, and click dbl_reg.tpy. From the Tree Structure, 

select the Primary Elec Meter Item, then click the Tuning tab to view the Tuning Data Form, as 

shown in Figure 3.20.  

From the 18 bills available in this tuning, deselect the 6 summer bills: July, August, and 

September of 1990 and 1991. At the very bottom of the Tuning Data Form, you can see that the 
regression equation becomes:  

kWh 1204.7 #Days 232.21 HDD 43.15 CDD  

kWh = baseline usage for the given month 

1204.7 = Base load constant  

#Days = number of days in this month  

232.21 = regression coefficient for use per heating degree-day  

HDD = heating degree-days in this month  

43.15 = regression coefficient for use per cooling degree-day  

CDD = cooling degree-days in this month  

Now deselect all bills except those in the summer months. Now the regression equation becomes:  
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kWh 157.4 #Days 0 HDD 61.49 CDD  

Heating Degree Days can be deselected in the Tune with field to correct the T-Stats.   

 

Figure 3.20 Tuning Data Form, All Points selected.   

Reselect all except the summer months, as described in step 2.  

Use the Tree Structure to select the Modification Item attached to this meter. This will display the 

Modification Setup Data Form.   

Note that the first Specification Option is selected. This option tells Metrix to modify the regression 

coefficients for the period defined by the Effective Dates (6/15/1990 - 2/15/92).  

Click Regression Modifiers to view the Regression Modifier Data Form, as shown in Figure 3.21  
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Figure 3.21 Regression Modifiers for Summer Coefficients  

Here you can see the percentage adjustments which change the school year coefficients to equal 

the summer vacation coefficients. For example, the Base load coefficient changes from 1204.7 to 
157.4, a reduction of 86.9%. The heating degree-day coefficient changes to 0, which is a -100% 
adjustment. The cooling degree-day coefficient is reduced by 29.84%.  

To see the effect of these adjustments, click the Modification History tab to see the Modification 

History Data Form, also known as the Factor History, as shown in Figure 3.22.  

Here you see a list of billing periods, which correspond to each electric bill entered for the meter. 

The column labeled "On-Peak + %" shows the overall adjustment in each bill resulting from the 
change in the coefficients.  

Note that only the summer vacation bills have the adjustment. The school year months are 
checked as "Manual", and 0% has been manually entered for these months. Metrix assumes that 

any changes in regression coefficients will adjust all bills in the effective period, so you must 

manually turn off the adjustment for those months you do not want changed. You must update this 
data form as new bills are entered to be sure the modification is implemented as desired.  
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Figure 3.22 Factor History for Summer Vacation Bills  

To see the effect of the Modification, close the Modification Data Forms, and open the Primary 
Elec Meter Item to which it is attached. This is the Baseline Inspection Data Form for the meter, 

whose graph is shown in Figure 3.23.  

Since there is no Measure for this meter, the Target and Baseline lines on the graph are the 

same. Note that the Baseline closely follows the Actual bills, even for the summer vacation 
months. You can also print out the Verification Summary report, which contains the degree-days 

for each billing period, and confirm that the baseline usage for the summer vacation months is 
calculated using their coefficients.  
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Figure 3.23 Resulting School and Summer Vacation Bills  

Measures  
Both Measures and Modifications affect the meter to which they are attached. Though their inputs 

are very similar, their impacts on a meter are very different. The Target scenario is calculated 
using the Baseline plus Measures; whereas, Modifications are used to modify the Baseline 

scenario.  

Measures represent actions taken to improve the utility performance of a facility. They usually (but 

not always) decrease utility usage and costs. Measures only affect the Target Scenario. Initially, 
the Target Scenario is equal to the Baseline Scenario. If you create a Measure for an electric 
meter which reduces usage by 25,000 kWh per month (for example, for a lighting retrofit), then the 

Target Scenario will have 25,000 kWh less per month than the Baseline Scenario. If a meter has 
no attached Measures, then the Target and Baseline Scenarios will be the same.  

A measure represents an action taken to improve the utility performance of a facility that you want 
to track. For example, you might replace your existing lighting system with a more efficient fixture 

type. Or you might upgrade your HVAC control system. You can enter your expected savings in 
Metrix, to see if you meet the target.  

You do this by creating Measures. As a simple example, if you install flow restrictors which you 

expect to reduce water usage 15% each month, you can create a measure which sets a Target at 

15% below the Baseline. Then you can compare the actual usage to the target, to see if you are 
meeting the target.  
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In a performance contract, you can use Measures to represent the “guaranteed” savings goals.  

You can establish separate measures for each meter. The monthly impacts can be positive or 
negative, in absolute values or percentages. A meter can have more than one measure impact it; 

the effects are cumulative. Each measure has a beginning and end date, so you can specify when 
they take effect.  

This section discusses how to apply Measures. Each subsection explains the important points of 
each type of Measure.   

Direct Entry – Enter changes to individual bills manually.  

Regression Modifiers – Enter modifiers to the fit line to change the regression equation directly.  

Creating Measures  

1. Use the Tree Structure to select the existing Meter Item which the measure will affect. 

Right-click on the Meter Item and, from the drop-down menu, select “New”, then “Measure”.   

2. Click the new Measure Item to open its Measure Setup Data Form, as shown in Figure  

3.24. Notice that, in the Specification Options field, the selected option states “Directly  

Enter Factor History of periodic changes in utility usage”. This is the default option for 
Measures. Notice the Effective Dates for this Measure. These dates should be set to the 

time period to which you want this Measure to apply.  

  

Figure 3.24 Measure Setup Data Form  

3. Click on the Measure History tab to view the Measure History Data Form, also known as 

the Factor History Form, shown in Figure 3.25. This Measure shows a 10 to 25 percent 
decrease in consumption per month and a 0 to 30 percent decrease in demand per 

month. An ECM that might require this type of measure be added might be improved air 
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conditioning or chillers, as savings peaks in the warm months and is down in the cooler 

months  

  

Figure 3.25 Measure History Tab  

Time Periods: The Time Periods field designates how the dates are delimited in the End Dates 

column. In Figure 3.25, the Monthly option designates the End Dates to fall at the end of every 
month. The Quarterly option would cause dates to fall at the end of every quarter. The Billing 

Periods option causes the End Dates to reflect the bill dates in the Register. Note that changing 
the Time Periods field after you have entered Measure values causes them to be reset or offset to 
different months.   

Auto-Repeat: Rather than requiring you to copy the Measure into every year that it applies to, you 
must only fill in the first year. Metrix will copy the Measure into the corresponding time period 

every year thereafter, for the life of the Measure. The Measure must, however, cover 365 days of 
bills. Near the bottom of Figure 3.25 is a message which reads “The last 365 days of % changes 

or offsets entered in the first <12> rows through <1/31/1994> will auto-repeat thereafter on a 
365day cycle except in manual rows.” This field allows you to offset the beginning of the Measure. 

In Figure 3.25 the last, or most recent, 365 days contained in the first 13 bills (ending on 
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1/31/1994) will be repeated until the end of the Measure, which you set in the Effective Dates field 

in the Measure Setup Data Form.   

Manual Entry: To the left of the End Dates column, the Manual column allows you to select 

specific bills. If you check one of these bills anywhere except in the first year of the Measure, you 
may make additional adjustments to account for special, one time occurrences. These changes 

will not be auto-repeated, and they will override the auto-repeat function described in the previous 
item.  

Measures - Regression Modifiers  

In the preceding section for Direct Entry, we saw how a Measure can be used to account for an air 
conditioning and chiller upgrade. Obviously, your energy savings is going to correlate strongly 

with cooling degree days. Instead of estimating your energy savings as a percentage or offset, 
you can estimate the effect on your regression equation. Say you obtained the regression 

equation shown below from your tuning period.  

kWh 1204.7 #Days 43.15 CDD  

kWh = baseline usage for the given month 

1204.7 = Base load constant  

#Days = number of days in this month  

43.15 = regression coefficient for use per cooling degree-day  

You estimate that on average, you will use 25% less energy per CDD and 10% less energy per 

day (regardless of CDD). Your target can be adjusted to your estimations by filling out the 
Regression Modifiers Tab as in Figure 3.26. Notice that -25 has been inserted into the ClgDD field 

and -10 has been entered into the Baseload field. Notice the fields below; you can also modify 
coefficients for HDD and custom variables. Also, you can apply a Regression Modification to a 

specific TOU period.  
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Figure 3.26 Regression Modifiers Tab   

Metrix will automatically fill out the Measure History form to adjust your Target. The Measure 

History will begin with the first period of your effective date for the Measure. Figure 3.27 shows 
the new Measure History tab.  

  

Figure 3.27 Measure History Tab after Regression Modifiers are added   
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Figure 3.28 shows the effect these Regression Modifications have had on the Target. For the first 

12 months, the Baseline and Target are equal. However, after the Measure is effective, the Target 
is smaller than the Baseline. The difference varies with Days and CDD.  

  

Figure 3.28 Regression Modifier Effects on the Target   

After this point, measures can be created in much the same way as a modification. You can either 

enter Regression Modifiers which affect the tuning coefficients and then have Metrix automatically 
enter in the appropriate Factor History, or you can click the Measure History tab and enter 

periodic changes in utility usage directly in the Factor History Data Form.  

So you can refer to the section on Modifications to see further details about how to create different 

types of Measures. But remember: Measures are used to calculate the Target scenario from the 
Baseline; whereas, Modifications are used to adjust or modify the Baseline scenario itself.  

Variables  
Examples of Variables are the number of meals served per month at a cafeteria may affect water 
usage, or the weekly production quantity at a manufacturing plant may affect electric usage. 

Variables can be used to normalize the meter or just for benchmarking reports (for example, 
number of students would not directly affect energy consumption but you may want to compare 
the $/student in one school to another one).  

Manually Entering Historic Independent Variable Data  

If you haven’t added a Variable Item yet, to add a new Variable Item, right click on an existing 

Area Item and, from the drop-down menu, select “New”, then “Variable.  

Clicking on the Variable Item in the Tree Structure should open the Variable Information Data 

Form, shown in Figure 3.29. Enter the requested data.  
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 Figure 3.29 Variable Information Data Form  

Note: Beginning of Readings is an important field. It is the first day of the first reading. Suppose 

you had monthly production numbers you wanted to analyze with Metrix. If your first monthly 
reading is 1/31/2005, then you would type in 1/1/2005 as “Beginning of Readings.”  

The Variable History Data Form is shown in Figure 3.30. This Data Form lets you quickly enter 
past data for the variable.  

To add new rows, right-click anywhere in the data form. Select “Add Row (New)” to add a blank 
row with today’s date. Select “Add Row (Copy)” to add a copy of the row you right-clicked on. You 

must change the date before moving on.   

You may also use the arrow keys to move about the form. To add a new row, move to the last row 

and hit enter, or the down arrow.   

  

 Figure 3.30 Variable History Data Form  

Rows in the variables register may be highlighted, and multiple rows may be selected at once. It is 

also possible to delete rows from the variables register. 

Sub-Meters  
See the section for Sub-meters in the Advanced Topics section.  
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Rates and Charges   
Metrix calculates utility costs for the SimActual, Baseline, and Target Scenarios using rate tariffs, 
which contain the formulas for calculating costs from the physical units. These are compared to 

the utility costs from monthly bills in the Actual Scenario to determine if the Project is performing 
better or worse than expected.  

Normally, these rate tariffs should match the actual tariff that your local utility uses to calculate 
your bill. In some cases, you may wish to use an alternate tariff if exploring the possibility of 

switching to a new rate. You can also skip the use of tariffs altogether, and use simplified average 
utility costs. This is specified in the Cost Calculation Method field in the Meter Setup Data Form.  

Usually, you want the SimActual, Baseline, and Target costs calculated with the same rate tariffs. 
This is the case if you select Single Utility Rate Schedules in the Cost Calculation Method field in 

the Meter Setup Data Form.  

Metrix has a very powerful tariff module that enables you to model almost any utility rate structure, 

including load factor rates, time-of-use rates, demand ratchets, seasonally or monthly varying 
rates, etc. You can also compare “what ifs,” such as what is the impact of switching utility tariffs.  

As you create rate tariffs, you should store them in the Metrix Library for use in your Projects. 
Procedures for selecting existing tariffs from the Library and for creating new tariffs in Projects are 

described below.  

  

Figure 3.31 Selecting the Cost Calculation Method  

Creating Rate Tariffs  

To create a rate tariff, you must create a Rate Item, which comes attached with a Charge Item. As 

many Charge Items as necessary may be added to a single rate.   
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 Figure 

3.32 Rate Setup Data Form  

How to create a Rate Item  

1. From the Tree Structure, select the existing Meter Item to which the rate tariff will apply.   

2. To add a new Rate Item, right click on the Meter Item and, from the drop-down menu, 
select “New”, then “Rate”.   

Click the Rate Detail tab for access to additional data.  

Note that we have not yet entered the actual cost per utility unit yet, such as “$/kWh” or “$/therm.” 

This is done in the Charges Item(s) attached to the Rate Item you just created. You will need a 
separate Charges Item for each type of unit (e.g. kWh vs. kW), for each seasonal variation in price 

(for example, summer versus winter gas prices), or time-of-day variation (for example, onpeak 
versus off-peak electric prices).   

How to create a Charge Item  

1. From the Tree Structure, select the existing Rate Item to which the Charge will apply.   

2. To add a new Charge Item, right click on the Rate Item and, from the drop-down menu, 
select “New”, then “Charges”.  
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Figure 3.33 Charge Setup Data Form  

3. Click the new Charges Item to display its Charge Setup Data Form, as shown in Figure  

3.34.  

4. Click the Charge Detail tab to specify more details about the charge.   

Some utilities have a monthly adjustment to their tariffs based upon other costs. For example, a 
natural gas tariff may have a base price of 0.40 $/therm, and an additional cost or credit of a few 
cents/therm, depending upon the wholesale price of natural gas each month. To account for this 
in Metrix, you do not need to add a new Charges Item every month. Instead, the Charges Item 
contains the base price, and you add a Fuel Adjustment Item to the Meter, in which you can add 
to or subtract from the base price as often as needed.  

Advanced Rate Tariffs  

Metrix must calculate utility costs for the SimActual, Baseline, and Target Scenarios. These are 
compared to the actual costs from the utility bills to determine if the Project is performing better or 

worse than expected.  

For each meter, Metrix can calculate these costs based on either the average utility costs from the 

actual bills, or based on utility rate tariffs you select in Rates View. You use the Cost Calculation 
Method field in the Meter Setup Data Form to specify the method to be used.   

If you select Single Utility Rate Schedules in the Cost Calculation Method field, the Rate and 
Charges Items which are attached to the Meter are used to calculate these costs (rather than an 
average rate).   

Utility rates, especially some electric tariffs, can be complex. The examples in this section show 
how to set up some complex tariffs.  

Note that utility rates only need to be set up once. The System Administrator can store rates in the 
Library. Any time that rate is needed you can simply copy it from the Library and into your Project.  

To explore some advanced uses of Utility Rates, review the topics below:  

Time-of-Use Rates—setting up rates that vary with time of day (for example, on peak, off peak).  
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Seasonal Rates—setting up rates that change with the season (for example, summer versus 

winter).  

Load factor Rates—also known as “hours use” electric rates, where kWh block sizes depend upon 

peak demand.  

Replacing Rates over Time—entering a time history of rates for  a 

meter.  

Time-of-Use Rates  

In time-of-use rates (also known as TOU rates or “time-of-day” rates) the price schedule varies 
with time of day and week. These are almost exclusively electric rates.  

To see an example of a simple TOU rate, from the File menu, open the Library file rates.lby. Find 

the 2TOU w/Dem Rate Item in the Generic Electric Rates section.   

This is an example of an electric rate with two time-of-use periods, On Peak and Off Peak. During 

the on-peak period, the energy price is 0.048 $/kWh, and during off-peak, it is 0.030 $/kWh. There 
is also a demand charge of 4.833 $/kW which does not vary with time-of-use.  

To see how this rate is set up in Metrix, click the On Peak kWh Charge Item to open its Charge 
Setup Data Form, as shown in Figure 3.34. Note that On Peak is selected for the Period field. This 

means that this set of charges will be applied to the On Peak electric usage for the Meter to which 
this rate is attached.   

  Click on the Off Peak kWh Charges Item. The Period field is Off Peak.  

You can create as many Charges Items as you need. You can have up to four different TOU 

periods: On Peak, Off Peak, Partial Peak (shoulder), and Super Off Peak. If the TOU periods 
differ over seasons, you can set up Summer On Peak, Winter On Peak, etc. To see an example of 

a TOU rate which varies seasonally, see the 2 Seas TOU Rate Items in the Library.  

  
Figure 3.34 The On-Peak kWh Charge  

Seasonal Rates  

In seasonal rates, the price schedule varies regularly during the year. Usually there are two 

seasons, summer and winter. In most cases, only the price changes (e.g. in summer the price is  
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0.09 $/kWh, and in winter it is 0.05 $/kWh). However, the entire structure can change as well (e.g. 

winter charges may be flat, while summer charges are tiered or even vary by time of day).  

Metrix enables you to vary rates by season as needed. Our example shows a simple two season 

gas rate.   

From the File menu, choose Open Example, and click rate_ex2.tpy.   

Switch to Rates View. Note the GNG-GS1 Rate Item which is attached to the natural gas meter. It 
has two Charge Items, labeled Winter and Summer. Click the Winter Charge Item to display its 

Data Form, as shown in Figure 3.35.  

The key fields for specifying the season are the Starts On and Ends On dates. In this example, 

the winter charges are in effect from October 1 through April 30. The prices for the winter months 
are 0.559 $/therm for the first 5,000 therms, 0.513 $/therm for the next 5,000 therms, and 0.478 
for all additional therms. If you open the Summer Charge Item, you see its effective dates are May 

1 through September 30, with lower prices per therm.  

  
Figure 3.35 The Winter On-Peak Charge  

You can create as many Charge Items as you need. If the rate differed over four seasons, you 

could set up Charge Items for Summer, Fall, Winter, and Spring. If your effective dates overlap, or 
if there is a gap (a period uncovered by a Charge), the Quality Control check issues a Warning or 

Error.  

If a billing period straddles a change of season (for example, part of the billing period is in summer 

and part is in winter), Metrix calculates the charges as follows:  

Two separate charges are calculated, one as if the entire bill fell in the summer season, and the 

other as if the entire bill fell in the winter season.  

The final bill is the average of the two separate charges, weighted by the number of days in each 

season. For example, if the billing period is 30 days, and 11 days fall in the summer season and 
the remaining 19 days are in the winter season, then the summer bill from step 1 above is 

multiplied by the factor 11/30, and the winter bill by 19/30. The products are added for the final 
bill.  

To verify that the seasonal rate has been entered correctly, click on the Primary Gas Meter Item 
to which it is attached. Click the Register tab to see that the Meter Register Data Form displays 
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the calculated costs for the SimActual. The OnPkCo column shows the therm costs for each 

billing period.  

Load factor Rates  

Load factor rates usually only apply to electric tariffs. These are kWh tiered rates, where the size 

of the kWh tiers is a function of demand for the billing period. They are also known as “hours use” 
schedules.  

To see our example load factor rate, from the File menu, choose Open Example, and click 

rate_ex2.tpy.   

Note that the Mobile LF M5 Rate Item, attached to the electric meter, has two Charge Items 
labeled Energy and Demand.   

The kWh charges for this rate tariff are calculated as follows:  

0.0640 $/kWh for the first 75 hours of use multiplied by the Billed Demand for the period. This 

means the billed kW for the period is multiplied by 75, to get the size of the first kWh tier. So if the 
billed demand is 1,200 kW, then the first 90,000 kWh are 0.0640 $/kWh.  

0.0572 $/kWh for the next 300 hours of use multiplied by the Billed Demand for the period. This 
means the billed kW for the period is multiplied by 300, to get the size of the second kWh tier. So 

if the billed demand is 1,200 kW, then the next 360,000 kWh are 0.0572 $/kWh.  

0.0414 $/kWh for the all remaining kWh. So if the billed demand is 1,200 kW, then all kWh above 

450,000 kWh are 0.0414 $/kWh.  

Billed Demand is the greater of the metered demand for the current period, or 90% of the highest 

metered demand in the preceding 11 months. This is called a Demand Ratchet.  

Click the Energy Charge Item to open its Setup Data Form, as shown in Figure 3.36. Click on the  

Charge Detail tab to display the Charge Detail Data Form shown in Figure 3.37. Look at the Utility 

Tier Fields in the Detail Data Form. The costs per kWh are entered in the Charge column, and the 
hours of use are entered in the Size column. However, the values in the Size column can either 

be interpreted as hours of use, or as fixed kWh tiers.   

To specify which interpretation is to be used, look at the Special Load factor Provisions fields. 

Because 0 is entered for the Standard First Tier, Metrix knows that there are no “standard” tiers 
for this Charges item (in a standard tier the Size is fixed kWh). And because 1 is entered for the 

Load factor First Tier, Metrix knows that starting with the first tier, all tiers are to be interpreted as 
load factor tiers for this Charges item (in a load factor tier the Size is hours of use).  

Note: As an added complication, though not in our example, some rates change back and forth 
between standard and load factor tiers. For example, a rate may start out with standard tiers, let's 

say 0.06 $/kWh for the first 100,000 kWh, and 0.05 $/kWh for all remaining kWh, up to 400 hours 

of use, after which the price is 0.04 $/kWh. The Special Load factor Provisions fields would have 1 
for the Standard First Tier, 3 for the Load factor First Tier, and 400 for the Load factor Threshold. 

See the generic rate named Std/Lf Combo to see how this rate is entered.  

A very important variable in load factor rates is the demand, which is multiplied by the hours of 

use. In most rates, this is the Billed demand, but it can be the Metered demand. You specify which 
type of demand to use in the Load factor Tier Limits field in the Utility Rate Details Data Sub-form.  
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To verify that the load factor rate has been entered correctly, open the Primary Elec Meter Item to 
which it is attached. You see the Meter Register Data Form displaying the calculated costs for the 
SimActual Scenario. The OnPkCo column shows the kWh costs for each billing period. The  
BilkW1 column shows the Billed Demand for each period, which is multiplied by the hours of use.  

  
Figure 3.36 The Charge Setup Data Form for a Tiered Rate  

  
Figure 3.37 The Rate Detail Data form for a Tiered Rate  

  

Pre-Loaded Rate Tariffs in Resource Folder  

From the Tree Structure, select the existing Meter Item to which the Rate Item will apply.  
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From the File menu, choose Open Library. Select the Library file you want to open, and click 

Open. Inside you will find a project with several Meter Items, each with several Rate Items 
attached.  

Fuel Adjustments  
Fuel Adjustments are particularly useful when a rate varies often. For example, gas companies 

often charge a commodity charge that fluctuates monthly. Instead of making a new rate for each 
month, a Fuel Adjustment can be used.  

How to create a Fuel Adjustment Item  

From the Tree Structure, select the existing Meter Item to which the Fuel Adjustment will apply. 

To add a new Fuel Adjustment Item, right click on the Meter Item and, from the drop-down menu, 
select “New”, then “Fuel Adjustment”.  

Click the new Fuel Adjustment Item to open the Fuel Adjustment Data Form, shown in Figure 
3.38.  

  

Figure 3.38 Fuel Adjustment Data Form  

Enter the data requested in the Data Form—this is simply a series of dates and price adjustments. 
The adjustments are $/unit (for example, “$/therm”) and can be positive or negative. You can also 

select the Static Values option so that you can just enter a fixed amount if necessary.   

The Adjustments are entered into the Value column.  

The Data Intervals field designates how the dates are delimited in the End Date column. The 
default End Dates are those in the Bill Register.   

By checking the Demand Box, you can adjust demand pricing.   
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Closing Access to Data Entry  
After all utility bill and independent variable data have been entered for the current billing period, 
you can close the data entered through that period so that it is not inadvertently modified.   

Only a System Administrator can close or open access to current data.  

From the Tree Structure, select the Project Item to display the Project Information Data Form.  

In the Current and Entry Close Dates field, enter the Entry Close date. Any billing period, weather 
data, or other variable data entered on or before this date will be closed.  

  Select the Close as Of check box next to the Entry Close date. Metrix automatically fills in the 

As Of field with the current date (entered earlier in this Data Form), as shown in Figure 3.39.  

 Figure 

3.39 Closing Current Data Access   

Note: Once data access is closed, adding modifications and measures becomes very difficult. 
Feel free to close data access, but if you do add a modification later, be sure to re-open data 

access first.  
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Chapter 4: Complete Meter Tuning  
Tuning a meter is a process which combines your knowledge of a facility with statistical analysis. 

Tuning consists of identifying the relationship (if any) between historic utility performance and 
weather or other variables. For example, does a meter's usage depend on heating degree-days, 

or cooling degree-days, or occupancy hours, or some combination of these variables? The end 
result of tuning is a set of coefficients which Metrix will use each month to calculate the Baseline 

Scenario—what your utility bill would have been if no changes were made to the facility.  

Accurate meter tuning is very important for tracking utility performance. Inaccurate tuning can 

result in inflated or underestimated cost savings. We will look at the following:  

Basic Tuning—overview of the steps used to tune individual meters.  

Tuning for Heating & Cooling DD’s—tuning a meter which serves both space heating and cooling 
equipment.  

Tuning for User-Defined Variables—tuning a meter which is affected by non-weather variables, 
such as production or occupancy hours.  

Statistical Indicators  
Since linear regression is a statistical calculation, there are several measures that Metrix uses to 
define a good fit. To determine whether a meter is tuned well enough, these measures are shown 

in the Tuning Data Form in the field titled “Statistical Indicators”. The industry standards for these 

measures are described in ASHRAE Guideline 14-2002:
1
   

1. CVRMSE (Coefficient of Variation of the Root Mean Square of the Error): 25 or lower for 

energy (or water), 35 or lower for demand.  

2. R2 (Quality of fit): 0.75 or higher, with 1.00 as perfect fit.  

3. T-Statistics (T-Stats): Positive 2.0 or higher for CDD and HDD, and greater than 2.0 or 
less than -2.0 for any user variable.   

4. Net Mean Bias (Bias %): Must be equal to or less than 0.005.   

For more information on these statistical indicators, please refer to ASHRAE Guideline 14-2002 

or a college statistics textbook.  

                                                        
1

 During the late 1990s and the early 2000s, most Metrix users only heeded the R2 value and T-statistics, keeping them in 

the range as detailed above. This was the recognized practice in the energy analysis industry. In the 2002, ASHRAE came 

out with Guideline 14, which specified not an R2 value, but instead a CVRMSE and a Mean Bias Error (along with 

Tstatistics). The energy analysis industry has been slow to catch on, still relying mostly on the R2 value. This was mostly 

due to the fact that Metrix 3 never had the CVRMSE and Mean Bias Error on the tuning screen—making it hard for energy 

analysts to tune to these values. However, more and more energy analysts are now minding the CVRMSE and the Mean 

Bias Error.   
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 Figure 4.1: The Tuning Data Form, Statistical Indicators  

Selecting the Tuning Variables  
The key to meter tuning is determining which variables are most important in predicting utility 

performance. For example, if a gas meter is only measuring the usage of a space heating 
furnace, then gas usage would show a strong dependence upon weather (specifically heating 

degree-days). Other meters may not be dependent upon weather at all. For example, water meter 
may solely be dependent upon occupancy.  

This tuning step consists of selecting those variables which are important and statistically valid for 
a given meter. Users can select up to five variables to tune a single meter—heating degree-days, 

cooling degree-days, and up to three user-defined variables (for example, meals served, tons of 
steel produced, guest-nights).   

Your selection of variables should be guided by your knowledge of what areas the meter serves. 
Consider a few examples:  

• If the meter serves heating equipment and miscellaneous appliances but not cooling 

equipment, you would not select cooling degree-days as a variable.  

• If the meter serves both heating and cooling equipment (for example, an all electric 

facility, or one with gas-fired heating and cooling), you might select both heating and 

cooling degree-days.  

• If the meter serves manufacturing or other equipment which is not sensitive to weather, 
one or more production variables should be selected.  

Variables: If the Auto-Tune function did not choose the correct variables to tune this meter, 
specify which independent variables that should be used. Select the appropriate check boxes in 

the ”Tune with” area under the graphs. For example, if the current meter is a Natural Gas meter 
which is primarily serving heating equipment, you would select HDD for heating degree-days. You 

can select both heating and cooling variables, and up to three user-defined variables.  

Graphs: Use the drop down menu at the top of the Graph area to switch between different graphs. 

Each graph represents the bill data of the Tuning Period plotted versus a different independent 
variable. Viewing these graphs can help you identify which variables have strong relationships 

with the bill data and which do not.   

T-Stats: Metrix also gives a statistical indication of which variables have strong correlations. The 

“T-Stats” column underneath each graph indicates which of the selected variables have a strong 
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fit with the bill data, and which do not. A value of +2.0 or higher for CDD or HDD (or greater than 

+2.0 or less than -2.0) indicates the variable is valid. Again, trying several combinations is 
important, because each iteration will yield different T-Stats.  

  

Figure 4.2: The Tuning Data Form, Tuning Variables  

Variable Sample Project  

Some utility meters are dependent upon non-weather variables, such as occupancy, production, 

etc. For example, water usage is more likely to be sensitive to occupancy.  

Metrix comes pre-loaded with an example of such a meter. We will look at an electric meter which 

serves manufacturing equipment instead of space heating or cooling systems.  

1. From the File menu, choose Open Example, and click var_tune.tpy.   

2. From the Tree Structure, click the Widgets Variable Item. In the Variable History Data 
Form you can see the widget production inputs.  
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3. Click the Primary Elec Meter Item and select the Tuning tab to see how the Widget 

production variable is included in the tuning regression, as shown in Figure 4.3.   

4. Note that the Regression Variable check box for Widgets (the check box to the immediate 
left of the “Wid” label) is the only one selected. This means this meter is only tuned to 

widget production and the resulting fit line in the Tuning graph matches the actual points 
quite closely.  

  

Figure 4.3: Tuning for a User-Defined Variable  

Selecting the Tuning Periods  
The first step of tuning is selecting which time frame to use for the regression analysis. You 
should try to use periods in multiples of a year, not 18 months, or 7 months, but rather, 12 months 
or 24 months. As a general rule, you should use as many bills as you can, with the following 

guidelines:  

1. If changes were made to the facility which significantly alter the usage patterns for the 
meter from that time on, do not include bills from both before and after the changes in the 
tuning period. Choose all “before” or all “after” bills. For example, if a natural gas meter 
measured a facility in which the fifty year-old boiler was replaced, you should only tune to 
gas bills before the replacement so you can find the savings with the new boiler.  
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2. If there are continuous changes in a facility which affect meter usage patterns, use the 

most recent bills available. For example, many commercial facilities are experiencing 
“plug creep” as more and more PC’s are installed over time. As a result, non-weather 

sensitive electric usage is increasing. This is difficult to quantify, but the good news is, 
these meters can still be tuned to meet the criteria for statistical indicators and therefore 
be a good fit to the facility. Again, it is important to use the most recent year or more of 

past electric bills in the tuning period.  

3. If a one-time event causes unusually high or low usage for a billing period, you should 

exclude that individual bill from the tuning period. For example, if a facility is shut down for 
a few weeks for remodeling, the utility bill for that period may be unusually low, and 
should not be included.  

In the “Tuning Period” field, shown in Figure 4.4, enter the number of bills you wish to view, then 
enter the number of the bill you wish to start with. Look at the “starting on” and “ending on” dates 

to ensure they reflect your Tuning Period.  

For example, for one year starting with the first bill in the Register, enter 12 in the “bills” field, and 

1 in the “start at #” field. In other words, use 12 bills, starting with the first. If you wanted to tune 
for a period starting three months after the first bill in the register, enter 12 in the “bills” field, and 3 

in the “start at #” field. In other words, use 12 bills, but start with the third.   

The bills included in the Tuning Period are shown in bold with a gray background in the Register 

field of the Tuning Data Form. This area is highlighted in Figure 4.4.  
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Figure 4.4: The Tuning Data Form, Tuning Period  

  

Selecting the Balance Point Temperatures  
If you have chosen heating or cooling degree-days as tuning variables, then you must also select 
the corresponding Balance Point Temperatures. There are separate Balance Point Temperatures 

for heating and cooling. The Heating Balance Point Temperature is defined as “the outdoor 
temperature above which no space heating is required.” Similarly, the Cooling Balance Point 
Temperature is defined as “the outdoor temperature below which no space cooling is required.”  

Since the Balance Point Temperature is used in calculating Degree Days, you can have a 
significant impact on the regression line by changing the Balance Point Temperature.   

During the Auto-Tune process, Metrix makes a first guess at the Balance Point Temperature. 
Sometimes this value is optimized and cannot be improved upon. In other situations, particularly 
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when selecting or deselecting some bills, changing the Balance Point Temperature can affect the 

fit dramatically.  

The Balance Point Temperature is adjusted with the arrow buttons in the row corresponding to 

that variable. Check the CVRMSE and the R2 value to monitor if the fit is improving.   

Note: If you are tuning for a single weather variable, the baseload / # days coefficient in the 

regression equation must be zero or higher.   
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Figure 4.5: The Tuning Data Form, Balance Point Temperature  

Buildings have their own set of Balance Points for heating and for cooling and they may not be 

the same - even within the same building. The Heating Balance Point can be defined as the 
outdoor temperature at which the building starts to heat. In other words, when the outdoor 
temperature drops below the Heating Balance Point, the building’s heating system kicks in. 

Conversely, when the outdoor temperature rises above the Cooling Balance Point, the cooling 
equipment switches on.  
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Figure 4.6: Determining the balance point using a kWh/day vs. Outdoor Temperature graph  

One way to find the balance point temperature of a building, is to graph the Usage/day vs. 
average Outdoor Temperature (of the billing period) as shown in Figure 4.6.   

Notice that Figure 4.7 presents two trends. One trend is flat, and the other trend slopes up and to 
the right. We have drawn red lines signifying the two trends in Figure 4.7. The flat trend 

represents Non-Temperature Sensitive Consumption, or Baseload, which is electrical 
consumption that is not related to weather. Non-Temperature Sensitive Consumption is roughly 

the same every month, about 2450 kWh per day. Examples of Non-Temperature Sensitive 
Consumption include lighting, computers, miscellaneous plug load, industrial equipment and well 

pumps. Any usage above the horizontal red line is called Temperature Sensitive Consumption, 
which represents electrical usage associated with the building’s cooling system.   

The Temperature Sensitive Consumption only occurs at temperatures greater than 61°F. The 
intersection of the two trends is called the Balance Point, or Balance Point Temperature, which is 

61°F in this example. Notice, as the outdoor temperature increases, consumption increases. As it 
gets hotter outside, the building uses more energy, thus the meter is used for cooling, but not 

heating. The Balance Point Temperature we found is the Cooling Balance Point Temperature (not 
the Heating Balance Point Temperature).  
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Figure 4.7: kWh /day vs. Average Outdoor Temperature   

  

 

Figure 4.8: Therm/day vs. Average Outdoor Temperature  

We can view the same type of graph for natural gas usage in Figure 4.8. Notice that the major 
difference between the two graphs (electric and gas), is that the Temperature Sensitive trend 

slopes up and to the left (rather than up and the right). As it gets cooler outside, they use more 
gas, therefore, they use gas to heat the building.  

Baseline Equation  
This is always displayed in blue font at the bottom of the Meter Tuning Tab. Understanding the 

modifiers and coefficients in this equation can help you better tune your project.  

  

Temperature  
Sensitive  
Usage   

Non - Temperature  
Sensitive Usage   

Balance Point  
Temperature   

  

Temperature  
Sensitive  
Usage   

Non - Temperature  
Sensitive Usage   

Balance Point  
Temperature   
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Usage = (Coefdays* Ndays) + (CoefCDD * CDD’s) + (CoefHDD * HDD’s) + (Coefvar1 * N var1) + (Coefvar2 * 

N var2) + (Coefvar3 * N var3) + Constant  

• Usage = The baseline amount of a utility for a billing period.   

• Coeffxxx = The regression coefficient for this variable.  

• Nxxx = Total quantity of the given variable during the billing period.  

• Constant = The baseload constant.  

It is very common for meter data to tune sufficiently well to weather using CDD or HDD. In these 

instances the baseline equation simplifies to degree days and number of days components.  

Selecting and Deselecting Bills  
Bills that are selected and included in the regression have a check mark next to the date in the 
tuning register (not the bill register tab which is for estimated bills). Their points are graphed in 

blue. Deselected bills are unchecked and are graphed in white. Users can click in either the 
column or on the graph to change selection status.  

Selecting and deselecting bills should be approached with caution. Each bill that is deselected for 
any reason is eliminated from the regression and causes the resulting baseline to represent the 

bill data less faithfully. On the other hand, without deselecting some bills it may be impossible to 
fit a statistically significant line to the data. If you are approaching this bill tracking project as an 

Energy or Building Manager for a company, it may be acceptable to deselect bills based on your 
knowledge of the facility. It is important to deselect as few bills as possible to maintain the 

integrity of the project. Remember the object is not to get the highest R2 value, but rather to best 
represent the building energy usage patterns during the Tuning Period.   

Metrix may determine some bills in the Tuning Period to be outliers or less statistically significant. 
Bills that are underlined after auto-tuning can be selected/deselected (which ever it currently isn’t) 

to get a better set of statistical indicators. That does not necessarily mean the fit is better. For 
example, if half of winter bills are underlined for a gas meter, that could only represent half the 

trend: that would be improper.   

You must determine whether these selections and de-selections are valid.  
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Figure 4.9: de-selecting an outlier point   

If the bill is a legitimate outlier caused by unusually high or low usage during one month, then it 

may be excluded from the regression. If there is a bill that Metrix did not deselect, but that is 
causing the fit to fall outside acceptable parameters, it should also be excluded.  

Bill Matching  
De-selected bills and weather insensitive data can still be used in your Baseline through “bill 
matching.” This is the process of directly comparing the value of a specified bill or group of bills as 
the baseline value of a corresponding bill at a future date.   

Often times there are meters that have zero correlation to weather. One such notoriously hard to 
tune meter is the lighting meter. For example: a parking lot timer/sensor might catch a few cloudy 
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days, but it is really matching sunrise and sunset more than temperature. These meters can be 

good candidates for a complete bill match.  

How Metrix calculates the Baseline when Bill matching:  

1) A bill match modification is added to the meter. (good supplementary reading would 

be the section on modifications)  

2) Users may select to apply it to included bills or excluded bills. Both boxes checked 

means a full bill match. Only checking the excluded bills is a partial bill match where 
selected bills are still being tuned with a regression equation.  

3) Then, for the bill matched bills, Metrix determines an average consumption value. (25 
days and 1000 kWh = 40kWh/day) A common mistake is to expect the exact same 

amount for every bill in following months, but not every time will corresponding annual 
bills have the same number of days. For a fair comparison, both bills must have the 
same number of days, therefore estimation is necessary.  

4) An average cost value may be necessary if no rate has been attached to the bill 
matched meter. The total cost of the utility is averaged in a similar manner: total cost / 

days or consumption cost / days.  

Bill Matching One Bill -If a bill causes an unacceptable fit, but your knowledge of the facility 

dictates that this usage is reasonable for this month, and will be repeated in following years, it is 
possible to compare future usage during this month without using the regression line.   

Follow these steps:  

1. Click the “Bill Match” button on the Meter Tuning Tab.  

2. Find the meter you are tuning in the Tree Structure. You will see that a Bill Matching 
Modification appears underneath the meter, as shown in Figure 4.10.   

  

Figure 4.10: Meter with Bill-Matching Modification Attached  

3. Click on the Modification Item. The Modification Setup Data Form will appear. Uncheck 
the “Included Bills” option in the “Match” field, leaving only “Excluded Bills” checked. This 

means that only excluded, or deselected, bills will be Bill Matched.   

4. You can select Absolute Offsets of Percent Offsets. In our example, we will select 
Absolute Offsets.  

Bill Matching All Bills- It may be possible to deselect one or more bills to improve the fit, but 
deselecting too many bills will render the regression meaningless. The only option left is to Bill 

Match all bills. Each future bill will be compared to its respective month in the Tuning Period to 
determine savings.   

IMPORTANT: Do not Bill match unless you have a complete 365 days of bills in the base year.  
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Follow these steps:  

1. Click the “Set Fit to 0” button to clear out any tuning.  

2. Then, click the “Bill Match” button.  

3. Check the Tree Structure to see that a Bill Matching Modification appears beneath the 

meter, as shown in Figure 4.11.  

  

Figure 4.11: Tree Diagram for Bill-Matched Meter  

4. Click on the Meter Item to display the Tuning Data Form. Change the graph x-axis to be 

Time. See how the baseline exactly matches all points in the base year.   

Tuning for Heating and Cooling Degree-Days  
If a given meter which serves both space heating and cooling equipment, it will likely be tuned to 
both heating and cooling degree-days.   

From the File menu, choose Open Example, and click all_elec.tpy.   

From the Tree Structure, select the Primary Elec Meter Item and click the Tuning tab to see its 

Baseline Tuning Data Form, as shown in Figure 4.12.  

With the Graph X-Axis set to Time, note that the summer months have a big spike, and the winter 

months have a smaller spike. With more than one variable selected (heating and cooling 

degreedays), the T-Stats field becomes more important. If either the Heating or Cooling Degree-

day TStats were less than 2.0, then it should not be selected as a variable for tuning.  
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Figure 4.12: Tuning for Heating and Cooling Degree-Days   

Switch the X-axis from “Time” to “Outdoor Temp.” to display the graph shown in Figure 4.13. The 

“V” shaped line is common of Outdoor Temperature graphs when the bill data has a relationship 
to Heating and Cooling Degree Days. This is also a convenient place to identify outliers. Simply 
select those points that do not fit into the V-shape.   

It is wise to check this graph every time the Auto-Tune function identifies a fit relating to Heating 

and Cooling Degree Days. Some plots which are scattered and should be Bill Matched, are 
incorrectly identified by Auto-Tune as Heating and Cooling Degree Day relations.  
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Figure 4.13: Tuning for Heating and Cooling Degree-Days   

Closing the Baseline Tuning Period   
After all historic meter and independent variable data has been entered, and after the baseline 
has been tuned for each meter, you should close the baseline tuning period so that historic data is 

not inadvertently modified. Any user can close tuning period data for an individual meter. A 
System Administrator can close the tuning period for the whole Project. The baseline tuning 

period for the Project begins at the earliest baseline start date of all meters, and ends at the latest 
end date of all meters.  
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Closing a Tuning Period for a Single Meter  

From the Tree Structure, select the Meter Item and click on the Tuning tab to open the Tuning 
Data Form.  

After you have finished tuning the meter, select the Closed check box, in the Tuning field, in the 
lower left corner of the Data Form. While the Closed check box is selected, any bill data or 

independent variable data for this meter which occurs in the tuning period cannot be edited.   

Closing a Tuning Period for the Entire Project  

Only a System Administrator can close a tuning period for an entire project.  

From the Tree Structure, select the Project Item to open the Project Information Data Form.  

In the Milestone Dates section, the Project tuning period start and end dates are automatically 
filled in based on the individual meter baseline start and end dates.  

To close the Project tuning period, select the Closed check box next to the start and end dates.  
Metrix automatically fills in the As Of field with the current date (entered earlier in this Data Form), 

as shown in Figure 4.14.  

 

Figure 4.14: Closing the Baseline Tuning Period 
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Chapter 5: Special / Advanced Topics  
Chapter 4 describes all the features of Metrix that you need to work with most Projects. This 

chapter describes advanced features of Metrix that you need for unusual situations. It covers 
advanced aspects of Project layout, meter tuning, measures, modifications, and rate tariffs.  

Quality Control  
The Quality Control feature is based on a list of “rules of thumb” which you can use to check your 
Project at any time. When you use this function, Metrix checks to see if your Project violates any 
of these rules. You run quality control by choosing Quality Control from the Performance menu or  

by clicking the Quality Control  button of the  

toolbar. It is advisable to run quality control periodically as you set up a new Project. In addition, 

Quality Control also runs every time Metrix is opened.   

Immediately after you run Quality Control, the Quality Control View appears below the Tree 

Structure. Any Item that has a problem is displayed with either an Error or a Warning Item 
attached to it.  

To run Quality Control: Open a project file, go to Performance > Quality Control.  

Errors: conditions that are not acceptable; a Metrix analysis is not correct until ALL errors are 

eliminated.  

Warnings: items that are abnormal or might need attention. Items such as an un-tuned meter or 

atypical bill duration are very common but not necessarily fatal. Example: perhaps a meter is 
billed bi-monthly. Some warnings that do cause serious problems include: items not attached to 

the project, orphan items, meters with the same name.  

Sub-metering   
Let's assume you are tracking a medical center. Your Project is achieving excellent savings, 
surpassing your target. Then, a new wing is brought on-line, and your utility bills increase 20-

25%. There go your savings, unless you can correct for the increased usage.  
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Metrix can handle this in two ways—a Modification or Sub-meter. Here, we discuss sub-meters.  

If a sub-meter is installed to measure utility usage for the new wing, it is easy to correct for the 
change. Simply set up a Sub-meter Item and enter the usage measured by the sub-meter. Metrix 

subtracts it from the SimActual Scenario and calculates what the utility costs would have been 
without the new wing.  

From the File menu, choose Open Example, and click SUBMETER.TPY. This is a fictitious 
medical center. The Performance Period began in late 1992. In early 1995, a new wing came 
online. A sub-meter was installed which measures electric usage and demand for the new wing.  

In the Tree Diagram, you can see that a Sub-meter Item is attached to the Primary Electric 
meter. Open the Sub-meter Setup Data Form. Note that this sub-meter uses the same Setup and 

Reading Dates as its parent meter. This means that whenever the parent meter is read, so is the 
sub-meter (so we won't have to enter read dates twice). The setup indicates that the sub-meter 

measures both kWh and kW, just like its parent.  

Open the Sub-meter Register Data Form, as shown in Figure 5.1. Note that the kWh and kW 

readings are “0” until the 1/14/95 bill. This is when the first Sub-meter reading occurred.   

  

Figure 5.1: Data in the Sub-meter Register  

The kWh and kW entered in the Sub-meter Register are subtracted from the parent Meter kWh 

and kW, and the remainder is stored in the SimActual Scenario. To see this, go to the Scenario 
Inspection associated with the Electricity Meter, as shown in Figure 5.2.   

In the Scenario Inspection graph, we see the most recent two years of tracking results. Note the 
Actual kWh points and SimActual kWh line match perfectly until the beginning of 1995. At that 

point, the Actual values increase significantly, as a result of the increased usage from the new 
wing. The Actual usage even exceeds the Baseline line at several points. However, the 
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SimActual usage shows what the actual kWh would have been without the new wing. So the 

SimActual  

 

Scenario is now the one we should use for performance results.  

Figure 5.2: The SimActual Scenario Reflects the Sub-meter Data  

Demand Delta-T Tuning  
Tuning to demand can be done in the same manner as tuning to consumption. Go to the Tuning 
Tab for your meter and select the box that says demand. When this box is checked, you will be 

tuning to demand. Instead of using HDD and CDD, demand is tuned to Heating Delta-T and 
Cooling Delta-T.  

It is recommended that users first be very familiar with tuning consumption data weather before 
tuning to demand.  

Tuning to demand is not quite the same as tuning for consumption. Typically, utility companies 
bill for the highest demand recorded in a given billing period. This may or may not correspond 
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well to weather. For example: a special holiday event could draw far more power in a short time 

than a weather event. User knowledge of the facility operations could make the difference.  

Metrix gives users the option to tune demand according to the Maximum temperature difference 

achieved in a billing period. Go to the project information tabs > project preferences > check the 
box for max demand delta T tuning. For demand data with a high weather correlation, this may 

provide a better fit to the data. It is based on the assumption that the maximum demand will 
coincide with the day having the greatest temperature extremes.  

How to Use Grouping in Metrix  
You can add any number of Groups to Metrix. For example: Region, Cost Code, Building Type, 
Leased/Owned, etc. For each of these groups, you will have Sub-Groups, to which Sites/Areas or 

Meters may belong. For example:  

  

GROUP  SUBGROUPS  

Region  

Western Region  

Eastern Region  

Central Region  

  

GROUP  SUBGROUPS  

Building Type  

Elementary Schools  

Jr. High Schools  

High Schools  

Administration Buildings  

  

You can find Groups in the Project level in the Report Groups tab. Select Add in the Group 
section.  
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You will then see a dialog box asking for the Group Name; add it.  

  

Label it and select ok. You will now see a SubGroup in the SubGroup section. Select it, then 
press the Edit button.   

 

Name the subgroup at the top of the form, and then select which sites/areas and meters belong 
to it. Here we selected the school areas and sites but not the Irrigation areas.  
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To add the other subgroups (in this case, Jr. High Schools, High Schools, and Administration 

Buildings), click on the Add button in the Sub-Groups section. Then you can name the new 
SubGroup, and select which Sites/Areas/Meters are associated with the Sub-Group.  

  

When you are done be sure to press Save (below the Subgroups Section), or your Grouping will 
not be saved when you click out of the groups tab.  
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It is not necessary to include all meters in your Sub-Groups; some may be left out if you want.  
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Appendix A – Glossary of Terms  
Balance Point   

The cooling balance point is the temperature at which the building starts cooling. The heating 

balance point is the temperature at which the building starts heating. This is a crude but effective 
definition. CDD’s and HDD’s are calculated using the balance point. The Cooling Balance Point 

need not necessarily be the same as the Heating Balance Point.  
  

Base Load Level (on utility bills)   

The base load level is the lowest load level measure during a company's annual or daily cycle.  

  

Base Load (the concept)   

The energy used that has nothing to do with heating or cooling the building. Baseload energy is 

usually composed of lights and computers and 24/7 fans and pumps.  
  

Base Year   

Base Year means two different things to two types of Metrix users. Base Year represents the 

year to which you are comparing current year's data. If you are using Metrix to calculate savings 
due to energy projects, then base year represents the period of time before the ECM’s were 

installed. If you are using Metrix to track your bills in general, then base year represents some 
year in the past that was selected for comparison to current year's data.  

  

Baseline   

Baseline is a confusing term because it appears to have many meanings in the energy industry.  

For this discussion, "Baseline" represents "how much energy would have been used during the 
Base Year period, given today's conditions", where "today's conditions", for the most part, means 

weather and number of billing days. Different utility accounting systems have different meanings 
for Baseline, unfortunately.  

  

Baseline Equation   

The Fit Line, which was created in Metrix when a regression was performed, has an equation, 
which is called the "Fit Line Equation." The Baseline Equation is the same as the "Fit Line 

Equation, except it can also have Baseline adjustments tacked onto it.  
Baseline Equation = Fit Line Equation +/- Baseline Adjustments  

  

Billed Demand   

Billed Demand is not the same as Metered Demand. Metered Demand is the highest kW value 

measured over a 15 minute interval (or some variation of this). Utilities often will charge their 
customers, not on Metered Demand (what they used), but rather on Billed Demand. Billed 

Demand is calculated for each billing period based upon several factors which can include.  
  

Billing Period   

The billing period is the time period for which a customer has been billed. The Billing Period 

stretches from the bill's start date to the bill's end date, and these dates typically reflect when the 
meter was read.  
  

BTU (British Thermal Unit)   
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The BTU is the standard unit of measurement for heat. A BTU is defined as the amount of energy 
needed to raise the temperature of one pound of water 1 degree Fahrenheit from 58.5 to 59.5 

degrees under standard pressure. One kWh has 3413 Btu’s.  
  

CCF   

An abbreviation for One Hundred Cubic Feet. CCF are used to measure consumption of water or 

natural gas. Sometimes a CCF of water is called a "Unit." A CCF of water is about 748 gallons.  
  

CDD   

See Cooling Degree Day  

  

Commodity Charge (aka, Energy Charge)   

Gas bills sometimes are broken up into commodity charges and transportation charges. The 

Commodity Charge is the charge associated with the amount of energy purchased from the 
supplier.  

  

Co-Generation Facility   

Privately-owned electric generation plant that produces electricity and heat by burning fossil 
fuels.  

  

Constant   

Meters do not directly measure energy or power, but rather measure some other factor which is 
then multiplied by a constant in order to determine the amount of energy or power used.  
  

Consumption   

The measured amount of energy or water used during a given period. This is different from 

demand, which can be thought of as the greatest rate at which the energy or water is delivered at 
any one time during the billing period. In terms of electricity  

  

Consumption Meter   

Some electricity meters measure consumption only, and not demand. These meters are called 
consumption meters.  

  

Contract Carrier   

A contract carrier is an oil or gas pipeline company that sells its services to the customer on a 
contractual basis.  

  

Contract Demand   

Some electricity rates require the utility to establish a Contract Demand for each individual meter. 
The Contract Demand is the capacity in kW that the utility has judged the customer might use at 

peak conditions. Customers are often billed for contract demand indirectly, such as, billed kW = 
the maximum of 50% of contract demand or current month's metered demand.  

  

Cooling Balance Point   

The cooling balance point is the temperature at which the building starts cooling. This is a crude 
but effective definition. CDD’s are calculated using the cooling balance point.  
  

Cooling Degree Day (CDD)   
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CDD’s are a way to measure how much cooling is required for a given period of time. They are 
calculated as follows: CDD’s for one day = difference between the balance point and average 

of the high and low temp. Note: there can be no negative CDD’s; if the daily average is less 
than the balance point then CDD = 0. When CDD’s are reported for a bill period, this is the sum 

of the daily CDD.  
  

Cost Avoidance   

Almost the same as Cost Savings, but different. Cost Avoidance is the difference between what 

how much utility usage would have cost had no ECM’s been installed, and how much utility 
usage did cost now that ECM’s have been installed.  

  

Customer Charge   

Many rates have a monthly or daily charge that customers pay, whether they use energy or not.  

Different utilities will call it customer charge, monthly charge, facilities charge, service charge, 
etc.  

  

Cubic Foot   

A Cubic Foot is the volume of gas required to fill one cubic foot of space at 60 degrees 
Fahrenheit at sea level (14.73 psi)  
  

Deduct Meter   

A Deduct Meter is a special in-line water meter used to measure water consumption that does 

not enter the sewer system and for which an adjustment is given in calculating sewer charges.  
  

Demand Charges (Therms)   

A charge for service that allows a customer to receive an unlimited (or specified) supply or 

volume of gas at any time throughout the year.  
  

Demand (Electric)   

The amount of electricity needed at any one moment in time (more so, any 15 or 30 minute 

period of time) in order to meet a meter's energy needs. Suppose you drove 100 mph for ½ hour. 
You drove 50 miles at 100 mph. You can equate the concept of demand to speed. In this case, 

mph is like demand, and miles driven is like energy. Remember  
  

ECM   

Energy Conservation Measure. This term is widely used to represent any energy efficiency 

project that will reduce energy expenditures. Similar acronyms include FIM (facility improvement 
measure), ECO (energy conservation opportunity).  

  

ECO   

Energy Conservation Opportunity. This term is widely used to represent any energy efficiency 
project that will reduce energy expenditures. Similar acronyms include FIM (facility improvement 
measure), ECM (energy conservation measure).  

  

Energy Accounting   

The process of monitoring and recording the consumption of energy and demand. Energy 
Accounting is a great first step in setting up an energy savings program for a facility. Once you 

understand how much energy you are using and where it is being used, you can determine 
where you can most easily save energy.  
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Energy Avoidance   

Almost the same as Energy Savings, but different. Energy Avoidance is the difference between 
what how much energy would have been used had no ECM’s been installed, and how much 

energy was used now that ECM’s have been installed. Not many energy analysts use this term 
for some reason.  

  

Equipment Rental   

Equipment, such as a water heater or a chiller, that is rented from a utility company, usually on a 
monthly basis.  

  

Estimated Bill   

Sometimes utilities cannot read a customer's meter due to factors such as employee illness, 
equipment malfunction, etc. When this occurs, the utility may choose to charge the customer for 

an "estimated bill." The estimated bill is determined based upon past usage history. In most 
cases the Estimated Bill is corrected the following month. Some gas utilities will send their 

customers monthly bills with Estimated charges for the past month, and the Actual charges for 
the month before that. Since the customer already paid the Estimated Bill for the prior month, the 
Actual Bill is used to "true up" the account by charging or crediting the customer for the overage 

or underage that the customer did or did not use for the estimated bill period.  
  

Fit Line   

Fit Line is another term for "best-fit" line, or the line that comes closest to all the points in the 

Metrix tuning graph.  
  

Fit Line Equation   

Every line can be defined by an equation, such as y = mx + b. The Fit Line Equation is the 

equation for the Fit Line in Metrix.  
  

FIM   

Facility Improvement Measure. This term is widely used to represent any energy efficiency 

project that will reduce expenditures associated with running the facility. This often means 
reducing energy usage, but could mean reducing cost of toilet paper or garbage service. Similar 

acronyms include ECM (energy conservation measure), ECO (energy conservation opportunity).  
  

Firm Service   

Customers usually pay more for gas or electricity that is sold with a guarantee (Firm Service) for 

delivery. The opposite is Non-Firm service for electricity or interruptible service for gas. In times 
of shortage, Non-Firm customers may not receive energy. This happened to many non-firm 
customers during California's notorious summer of 2001.  

  

Fuel Adjustment   

The additional charges or credits that some utility companies include in their bills to offset the 
variance in the price of the fuel used to generate electricity. This adjustment is typically 

represented as cents per kWh. It is not uncommon for fuel adjustments to be negative.  
  

Gas Cost Recovery   
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Most utility companies define Gas Cost Recovery as "the average cost per thousand cubic feet of 
gas purchased or produced for sale to the customers of the utility." In other words, it is the 

difference between what the utility paid for the gas and what they sold it to their customers for.  
  

HDD   

See Heating Degree Day  

  

Heating Balance Point   

The heating balance point is the temperature at which the building starts heating. This is a crude 
but effective definition. HDD’s are calculated using the heating balance point.  
  

Heating Degree Day (HDD)   

HDD’s are a way to measure how much heating is required for a given period of time. They are 

calculated as follows: HDD’s for one day = difference between the balance point and average of 
the high and low temp. Note: there can be no negative HDD’s; if the daily average is higher than 

the balance point then HDD = 0. When HDD’s are reported for a bill period, this is the sum of the 
daily HDD.  

  

Horsepower   

A horsepower is unit of measurement used to determine the capacity of a mechanism to do work. 
One Horsepower is the equivalent of raising 33,000 pounds one foot in one minute. 1 

horsepower equals 746 Watts of electricity at 100% efficiency.  
  

Interruptible Service  

Gas that is sold without any form of guarantee of delivery. Utilities are able to curtail delivery to 

their interruptible customers to allow for seasonal or shortfall adjustments. Gas billed to 
interruptible costs less than that sold on a Firm sales basis.  

  

Irrigation Meter   

An Irrigation Meter is a special in-line water meter used to measure water used for irrigation and 
thus for reducing water consumption assigned to sewer charges.  

  

Kilowatt   

1,000 Watts, or 3413 Btu’s  

  

kVA   

Kilovolt Amperes, often referred to as the Total Power, it is the sum of working power (KW), and 
the non-working power (KVAR). Non-working power is the current that is needed to electrify the 

system to reduce resistance and line loss.  
  

kW   

kiloWatt. The measure of demand or the rate at which electricity is used. Remember  

  

kWh   

kiloWatt hour. The measurement of consumption of electricity for a given time period. One kWh 
equals one kW of electricity used for one hour. Remember  

  

Late Charge   
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A fixed or percentage amount charged by the utility company when a customer fails to meet the 
utility's predetermined payment deadline.  

  

LF   

See Load Factor  

  

Load Factor (Electricity)   

Load Factor is a way to measure how the facility is using energy. Meters with high load factors 

represent meters that use nearly the same amount of energy all hours of the day. Meters with low 
load factors have a very high usage during peak times, and low usage during off peak times. 
Load Factor is calculated as follows:  

LF = kWh / (kW * # Days * 24 hrs/Day)  

  

MCF   

One thousand cubic feet, natural gas and perhaps water can be measured in billed in MCF. One 

MCF equals the heating value of 1,000,000 Btu (MMBtu).  
  

Meter   

A device used for measuring consumption or demand.  

  

Mid Peak   

Mid Peak is another name for Park Peak, or Shoulder, which are TOU Periods. A Mid Peak 

period might be from 8am to 10am and from 4pm to 6pm on weekdays.  
  

MMBTU   

One Million Btu.  

  

Multiplier   

Often referred to as Meter Constant. See Constant.  

  

Non-Firm Service   

Some utilities allow customers to receive Non-Firm service, as opposed to Firm service. Non-
Firm Service means that the utility does not guarantee service all the time, and therefore is less 

expensive. However, in times of power shortages, non-firm customers may not receive any 
power at all, as happened to many non-firm customers in California during the notorious summer 
of 2001.  

  

Non-Temperature Sensitive Usage   

The energy used that is not related to weather. This would include computers, lights, pumps, 
kitchen equipment, etc.  

  

Off-Peak   

A time period determined by a utility company to reflect the time of day when demand is at its 
minimum. Usually Off-Peak represents evenings, nights and weekends.  

  

On-Peak   

A time period determined by a utility company to reflect the time of day when demand is at its 
maximum. Usually On-Peak represents weekday hours.  
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Power Factor   

A method of determining the quality of energy being used at your facility. Facilities using large 

amounts of uncompensated fluorescent lighting or ac induction motors often have lower power 
factors. Power factors are measured in percentage, and customers are often billed if the power 

factor drops below a certain threshold, like 85% (and sometimes credited for higher power 
factors). Power Factor problems can be fixed using capacitors.  
  

Pressure Factor   

A billing factor that may be used to calculate the price of gas delivered to the customer at higher 

pressure.  
  

Primary Metering   

See Primary Service  

  

Primary Service (aka Primary Power)   

Primary Service is electrical service that is metered before the transformer (which will "step 
down" the voltage to a usable level). Utility customers who receive Primary Power, usually own 

or rent their own transformers, rather than have the utility provide them. When electrical service 
is provided through this type of metering, the meter is measuring raw power rather than 
transformed power. Electrical power, in order to be useful, must be converted to the correct 

voltage for the intended application. This is accomplished through transformers. When this type 
of conversion occurs, there is a slight loss of electrical energy through heat that is a by-product of 

the conversion process or transformation. Primary Electrical service is less expensive than  
Secondary Service, which is more common.  

  

Private Carrier   

An interstate gas pipeline company that owns the gas it carries.  

  

PSC   

Public Service Commission  

  

PSI   

Pound per Square Inch. This is a measurement of pressure.  

  

PUC   

Public Utility Commission  

  

Ratchet   

Some utilities charge customers for demand based upon not just the current billing period's 

metered demand (kW), but they also take into account previous months metered demand. A 
typical ratchet may read like  

  

Rate Schedule   

A set of tariffs that present the prices to be charged to the customers of the utility company for 
services or supply of commodity. It also lists the responsibilities of the utility company.  

  

Read Date   

Calendar date on which meters were read and recorded.  
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Regression   

Regression is a statistical operation, which graphically can be described as drawing a straight 

trend line (or "best-fit" line) as close to all the points in a graph as possible. The "best-fit" line, or 
regression, then is said to represent the points in the graph. Also called Tuning.  

  

Rider   

A variant to a tariff or rate schedule. Riders tend to make rates very confusing because bills don't 
always tell you that a rider is being applied. As a result, sometimes you cannot calculate your 
rate by hand because you don't know all the charges being applied.  

  

Savings   

The reduction in the quantity (of energy or water) that can be discerned from utility bills. This is 
similar, but not the same as the term, "usage avoidance", which some people use. What makes it 

more confusing, is that some people use the word "savings" to mean "cost avoidance", "energy 
avoidance" or the reduction in usage or cost that can be determined from utility bills.  

  

Secondary Service   

(Secondary Metering, Secondary Power) Electrical service that is metered after the transformer. 
Primary Service is metered upstream of the transformer (or on the primary side).  

  

Shoulder   

Shoulder is another name for Park Peak, or Mid Peak, which are TOU Periods. A shoulder period 
might be from 8am to 10am and from 4pm to 6pm on weekdays.  

  

Solid Waste   

Garbage  

  

Super Off Peak   

A few rates have a Super Off Peak Time of Use (TOU) Period. This is a fourth TOU period that 
would probably represent night hours and weekends.  

  

Surcharge   

A special charge, tax or fee billed to a customer that is not a standard part of a utility's tariff.  

  

Storm Water   

Water originating from rain or other outside sources that does not enter the sewer.  

  

Tariff   

A document or schedule filed by a utility company with its federal or state regulatory agencies 

that presents the rates charged to its customers for the services or commodity delivered.  
  

Temperature Sensitive Usage   

The energy used that is related to weather. This would mean air-conditioning equipment, chillers, 

cooling towers, boilers, hot water pumps, etc.  
  

Therm   

100,000 Btu’s  

  

Time of Use   
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Some rates bill their customers based upon the time of day the energy was used. For example, a 
rate may have On Peak, and Off Peak Charges. On Peak would represent the period of time in 

which energy is most in demand (and most expensive), and Off Peak would represent the period 
of time in which energy is least in demand (and least expensive). For example, in California, On 

Peak would be during week days, and Off Peak would be week day nights and weekends. Some 
TOU rates have 4 Time of Use periods.  

  

TOU   

Time of Use  

  

Transformer   

Power is transferred along transmission lines at very high voltage. Transformers are then used to 
"step down" or reduce the voltage to a usable voltage level.  

  

Tuning   

Tuning is the process of performing a regression (and is the term used in Metrix). A Tuning 
Graph is a graph that shows the points and the "best-fit" line. Tuning and Regressing are 

synonyms (as verbs). Tuning and Regression are synonyms (as nouns).  
  

Unit   

Some water companies charge for water in "units", which is the same as a CCF, and represents 

about 748 gallons.  
  

Watt   

A unit of measurement of electrical consumption. (The power used when one ampere of direct 

current (DC) flows through a resistance of one Ohm.)  
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Appendix B – Online Support Information 

Appendix B – Online Support Information  
Metrix Lessons on Our Homepage: http://www.abraxasenergy.com/metrix-4-tutorials.php  

• Lesson 1: A First Look at Metrix 4   

• Lesson 2: Laying Out Your Metrix Project  

• Lesson 3: Importing Bill Data into Your Metrix Project  

• Lesson 4: Importing Weather Data into Your Metrix Project  

• Lesson 5: Tuning Your Data for Weather  

• Lesson 6: Entering Savings Projections into Your Metrix Project  

• Lesson 7: Tracking Usage in an Existing Metrix Project  

• Lesson 8: New Features in Metrix 4  

Software Manuals 

http://www.abraxasenergy.com/metrixmanuals/metrix4usersguide.pdf 

http://www.abraxasenergy.com/metrixmanuals/reportmakerusersguide.pdf  

You can also go to: Hard Drive > Program Files > Metrix 4 > Docs Folder  

FAQ's http://www.abraxasenergy.com/faq.php   

Some else has probably wondered about the same thing. Lots of great tips and common 
solutions for energy managers.  

Weather Around the World 

https://www.abraxasenergy.com/energytoolbox/weathersearch.php  

Basically, we offer every airport code in the US and Canada, and about three thousand others 

around the world.  

HVAC Rules of Thumb https://www.abraxasenergy.com/hvac-rules-of-

thumb.php  

http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
http://www.abraxasenergy.com/metrix-4-tutorials.php
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http://www.abraxasenergy.com/metrixmanuals/metrix4usersguide.pdf
http://www.abraxasenergy.com/metrixmanuals/metrix4usersguide.pdf
http://www.abraxasenergy.com/metrixmanuals/reportmakerusersguide.pdf
http://www.abraxasenergy.com/metrixmanuals/reportmakerusersguide.pdf
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Useful info for inspecting usage patterns OR creating realistic savings targets.  

Appendix B – Online Support Information 

Emissions Calculator https://www.abraxasenergy.com/emissions/index.html  

Estimate based on state, fuel type, consumption and more; returns emissions including: CO2, 
CO, NOx, lead.  

Conversion Calculators 

http://www.abraxasenergy.com/conversion_calculator.php  

From or to just about anything.   

https://www.abraxasenergy.com/emissions/index.html
https://www.abraxasenergy.com/emissions/index.html
http://www.abraxasenergy.com/conversion_calculator.php
http://www.abraxasenergy.com/conversion_calculator.php
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Appendix C – Import File Formats  

MT1 Meter Register File Format  
The utility bill data has to be formatted in a certain way in order to import into Metrix. MT1 files 

are Comma Separated Value (CSV) files. To create an MT1 file using Excel just create a new 
worksheet and fill in the columns according to the values in the table below. Make sure that the 

worksheet doesn’t have any headers, just values.  

Some restrictions that should be noted:  

• No commas should be in any field.  

• No dollar signs.  

• First 11 columns must have data  

• The name and account fields must be less than 22 characters.  

• Fields with no value should be left blank (example: if there is no demand, leave it blank).  

• To properly save the file in Excel, save the file with the type “Comma Separated Values”, but 
type the filename inside quotes with .MT1 appended to it so that Excel saves the file using 

the correct extension. For example, in the filename dialog, you can name your file 
“BILLDATA.MT1”.  

  

Table C-1 Columns for MT1 Format  

Col  Col  Column Name  Field Value/Data Source  Example  

1  A  Format ID  MT1  “MT1”  

2  B  Meter Name  Meter Name   “Electric 3”  

3  C  Account #  Account Name  “0012345”  

4  D  Utility  

See Fuel Code column in Table  

C2 or C-.3 for the appropriate fuel 

code.  

“E”  

5  E  BTU/unit Factor  

How many Btu’s in the Energy  

Unit, i.e. there are 3413 Btu’s in a  

kWh  

“3413”  

6  F  BTUH/unit  

How many Btuh’s in the Energy 

Unit, i.e. there are 3413 Btuh’s in 

a kW  

“3413”  

7  G  Year  Meter read date year  “1999”  

8  H  Month  Meter read day month  “3”  

9  I  Day  Meter read date day  “5”  

10  J  Number of days in bill period  Number of days in bill period  “29”  

11  K  Total Cost  Billed amount for the account.  “1234.56”  

12  L  Miscellaneous  Service charges, late fees, etc.  ““1234.56”  

13  M  Credit  Credits, rebates, etc.  “1234.56”  

14  N  Tax  Tax  “1234.56”  

15  O  On Peak Quantity Cost  Where available from utility co.  “1234.56”  
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16  P  On Peak Quantity  On Peak Quantity  “1234.56”  

17  Q  Off Peak Quantity Cost  Where available from utility co.  “1234.56”  

18  R  Off Peak Quantity  On Peak Quantity  “1234.56”  
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19  S  Partial Peak Cost      

20  T  Partial Peak Quantity      

21  U  Super Off Peak Cost      

22  V  Super Off Peak Quantity      

23  W  On Peak Demand Cost      

24  X  On Peak Demand      

25  Y  Off Peak Demand Cost      

26  Z  Off Peak Demand      

27  AA  Partial Peak Demand Cost      

28  AB  Partial Peak Demand      

29  AC  Super Off Peak Demand Cost      

30  AD  Super Off Peak Demand      

31  AE  On Peak Supply Cost      

32  AF  On Peak Supply      

33  AG  Off Peak Supply Cost      

34  AH  Off Peak Supply      

35  AI  Partial Peak Supply Cost      

36  AJ  Partial Peak Supply      

37  AK  Super Off Peak Supply Cost      

38  AL  Super Off Peak Supply      

39  AM  On Peak Power Factor Cost      

40  AN  On Peak Power Factor %  Integer 0-100  “97”  

41  AO  Off Peak Power Factor Cost      

42  AP  Off Peak Power Factor %  Integer 0-100  “97”  

43  AQ  
Partial Peak Power Factor 

Cost  
    

44  AR  Partial Peak Power Factor %  Integer 0-100  “97”  

45  AS  Super Off Peak PF Cost      

46  AT  Super Off Peak PF %  Integer 0-100  “97”  

  

  

Default Conversion Factors and Energy Units in Metrix  

The tables below list the default conversion factors for the different fuel types. The utility 
abbreviations can be used in column 4 in mt1 files, and the conversion factors can be used in 

columns 5 and 6 of mt1 files.  

Table C-2 Default Quantity and Demand IP Units  
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Utility  

  

Fuel Code  

Quantity  Demand  

IP Unit  

Btu / Unit  

Conversion 

Factor  
IP Unit  

Btuh / Unit  

Conversion 

Factor  

Chilled Water  C  Ton-Hrs  12,000.00  Tons  12,000.00  

Electricity  E  kWh  3,413.00  kW  3,413.00  

Natural Gas  G  Therm  100,000.00  Therm/hr  1,000.00  

N. Gas (Vol)  V  CCF  102,000.000  KBtuh  1,000.00  

N. Gas (LgVol)  U  MCF  1,020,000.00  KBtuh  1,000.00  

Propane  P  gal  91,500.00  gal/hr  91,500.00  

Fuel Oil  O  gal  139,600.00  gal/hr  139,600.00  

Wood  X  Cord  17,100,000.000  kBtuh  1,000.00  

Steam  T  klb  1,040,000.00  kBtuh  1,000.00  

Solid Fuel  S  kBtu  1,000.00  kBtuh  1,000.00  

Gasoline  L  gal  114,000.00  gal/hr  114,000.00  

Diesel  D  gal  130,000.00  gal/hr  130,000.00  

Water  W  Unit  748.0519  Unit/day  31.1688  

Waste Water  R  Mgal  1,000,000.00  Mgd  41,666.67  

Garbage  B  yd3  27  yd3  27  

Biomass  Q  Ton  16,000,000  Ton-hr  16,000,000  

  

  

Table C-3 Default Quantity and Demand SI Units  

Utility  
Fuel  

Code  

Quantity   Demand  

SI Unit  

Btu / Unit  

Conversion 

Factor  

SI Unit  

Btuh / Unit  

Conversion 

Factor  

Chilled Water  C  kWh  3,413  kW  3,413  

Electricity  E  kWh  3,413.  kW  3,413  

Natural Gas  G  MJ  948.06  kW  3,413  

N. Gas (Vol)  V  m3  36,020.96  kW  3,413  

N. Gas (LgVol)  U  m3  36,020.96  kW  3,413  

Propane  P  L  24,171.74  L/hr  241,71.74  

Fuel Oil  O  L  36,878.41  L/hr  36,878.41  

Wood  X  MJ  948.06  kW  3413  

Steam  T  Ton  2,292,807.5  kW  3413  

Solid Fuel  S  MJ  948.06  kW  3413  
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Gasoline  L  L  30,115.61  L/hr  30,115.61  

Diesel  D  L  34,342.36  L/hr  34,342.36  

Water  W  m3  264.17  m3/day  11.01  

Waste Water  R  m3  264.17  m3/day  11.01  

Garbage  B  m3  35.31  m3  35.31  

Biomass  Q  Mtr Ton  17,633,834  
Mtr Tonhr  

17,633,834  

  

  

HLT Weather File Format  
Some restrictions that should be noted:  

• No commas should be in any field.  

• Gaps in weather are represented by -99; the weather station did not report due to technical 
difficulty or severe weather conditions. These must be substituted with values from nearby 

weather station or averages. User discretion is required. NOTE: leaving gaps in a weather 
file results in a fatal error during quality control checks; they must be addressed.  

• The name and account fields must be less than 22 characters.  

• To properly save the file in Excel, save the file with the type “Comma Separated Values”, but 

type the filename inside quotes with .HLT appended to it so that Excel saves the file using 

the correct extension. For example, in the filename dialog, you can name your file 
“WEATHER.HLT”.  

  

Table C-4 Columns for HLT Format  

Col  Col  Column Name  Field Value/Data Source  Example  

1  A  WBAN Code  Analogous to 3 letter airport code  “24233”  

2  B  Airport Code  3-4 Letters   “SEA”  

3  C  Weather Site Name  Up to 22 characters  “SEATTLE”  

4  D  Year  Year  “2010”  

5  E  Month  Month  “2”  

6  F  Hi Temp  for 1st day  “68”  

7  G  Lo Temp  for 1st day   “45”  

8  H  Hi Temp   for 2nd day  “70”  

  BR  Continues until end of month  Continues until end of month    

  

SM1 Sub-Meter File Format  
Some restrictions that should be noted:  

• No commas should be in any field.  

• No dollar signs.  

• First 10 columns must have data.  

• The name and account fields must be less than 22 characters.  
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• Fields with no value should be left blank (example: if there is no demand, leave it blank).  

• To properly save the file in Excel, save the file with the type “Comma Separated Values”, but 

type the filename inside quotes with .SM1 appended to it so that Excel saves the file using 
the correct extension. For example, in the filename dialog, you can name your file 
“SUBMETER.SM1”.  

  

Table C-5 Columns for SM1 Format  

Col  Col  Column Name  Field Value/Data Source  Example  

1  A  Format ID  SM1  “SM1”  

2  B  Sub-Meter Name  Sub-Meter Name   “Submeter 3”  

3  C  Account #  Account Name  “0012345”  

4  D  Utility  

See Fuel Code column in Table 

3.2 or 3.3 for the appropriate fuel 

code.  

“E”  

5  E  BTU/unit Factor  

How many Btu’s in the Energy  

Unit, i.e. there are 3413 Btu’s in a  

kWh  

“3413”  

6  F  BTUH/unit  

How many Btuh’s in the Energy 

Unit, i.e. there are 3413 Btuh’s in 

a kW  

“3413”  

7  G  Year  Meter read date year  “1999”  

8  H  Month  Meter read date month  “3”  

9  I  Day  Meter read date day  “5”  

10  J  Number of days in bill period  Number of days in bill period  “29”  

11  K  Leave Blank  Leave Blank  Leave Blank  

12  L  Leave Blank  Leave Blank  Leave Blank  

13  M  Leave Blank  Leave Blank  Leave Blank  

14  N  Leave Blank  Leave Blank  Leave Blank  

15  O  Leave Blank  Leave Blank  Leave Blank  

16  P  On Peak Quantity  On Peak Quantity  “1234.56”  

17  Q  Leave Blank  Leave Blank  “1234.56”  

18  R  Off Peak Quantity  Off Peak Quantity  “1234.56”  

19  S  Partial Peak Cost  Where available from utility co.  “1234.56”  

20  T  Partial Peak Quantity      

21  U  Super Off Peak Cost      

22  V  Super Off Peak Quantity      

23  W  On Peak Demand Cost      

24  X  On Peak Demand      

25  Y  Off Peak Demand Cost      

26  Z  Off Peak Demand      

27  AA  Partial Peak Demand Cost      

28  AB  Partial Peak Demand      
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29  AC  Super Off Peak Demand Cost      

30  AD  Super Off Peak Demand      

31  AE  On Peak Supply Cost      

32  AF  On Peak Supply      

33  AG  Off Peak Supply Cost      

34  AH  Off Peak Supply      

35  AI  Partial Peak Supply Cost      

36  AJ  Partial Peak Supply      

37  AK  Super Off Peak Supply Cost      

38  AL  Super Off Peak Supply      

39  AM  On Peak Power Factor Cost      

40  AN  On Peak Power Factor %  Integer 0-100  “97”  

41  AO  Off Peak Power Factor Cost      

42  AP  Off Peak Power Factor %  Integer 0-100  “97”  

43  AQ  
Partial Peak Power Factor 

Cost  
    

44  AR  Partial Peak Power Factor %  Integer 0-100  “97”  

45  AS  Super Off Peak PF Cost      

46  AT  Super Off Peak PF %  Integer 0-100  “97”  
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VA1 Variable File Format  
Some restrictions that should be noted:  

• No commas should be in any field.  

• No dollar signs.  

• First 6 columns must have data.  

• The name and account fields must be less than 22 characters.  

• To properly save the file in Excel, save the file with the type “Comma Separated Values”, but 

type the filename inside quotes with .VA1 appended to it so that Excel saves the file using 
the correct extension. For example, in the filename dialog, you can name your file 
“VARIABLE.VA1”.  

  

Table C-6 Columns for VA1 Format  

Col  Col  Column Name  Field Value/Data Source  Example  

1  A  Format ID  VA1  “VA1”  

2  B  Variable Name  Variable Name  “Widgets”  

3  C  Year  Meter read date year  “1999”  

4  D  Month  Meter read day month  “3”  

5  E  Day  Meter read date day  “5”  

6  F  Quantity  Variable Quantity  “1234.56”  

  


